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1 Product Overview 

This chapter gives an overview of Active@ Boot Disk.  

1.1 About Active@ Boot Disk 

Active@ Boot Disk is a powerful set of tools engineered to help you in a number of data 
recovery and data security situations. 

Active@ Boot Disk combines a number of powerful tools that let you recover lost data, 
reset Windows passwords, make computer system backups and securely erase data. 
Active@ Boot Disk starts when you start your computer from a bootable CD/DVD/BD 
Disc or USB Flash Media.  

Active@ Boot Disk suggests a customizable user interface. You can create shortcuts for 
the additional portable user’s tools on the Desktop and in the Start menu the same way 
as you do it in Windows Desktop environment. These shortcuts can be saved to USB 
media and restored when you boot up the system the next time even on the different PC 
configuration. Network Settings, current Display Resolution and Scale can also be 
customized and stored to USB the same way. 

When you use Active@ Boot Disk, you gain access to the drive's data on a physical level, 
and on a logical level, therefore bypassing the resident operating system. This allows 
you to lock selected volumes for your exclusive use. Locking a volume is important if you 
want to wipe the data residue from an unoccupied space on the drive, create a “clean” 
data backup or recover files or folders located on your system volumes. 

When you boot from the local hard drive, the operating system is not capable of locking 
the existing volumes. The recovery operation must have exclusive access to the target 
location. Otherwise if a service or another application gains access to the target location, 
it might write over the files that you are trying to recover, rendering them un-
recoverable. 

Here are some other functions that you can perform with Active@ Boot Disk by booting 
from the CD/DVD/USB: 

 Backup the system drive - If you back up the system drive with Windows 
running from the same drive, when you restore the backup, it will start as 
though you are recovering from a loss of power since the boot up will start 
with system integrity checking. If you back up the system drive with 
Windows running from an external drive, the restored system will start 
without any pit stops. 

 Wipe unused data from the system records and directories, from MFT (on 
NTFS), from unused clusters, from file slack space (see Active@ KillDisk). A 
"clean" wipe operation is not possible if the Windows is running from the 
same drive that you are trying to wipe the data from. If you wipe the data 
with the Windows booted from an external drive, it will be a “clean” wipe.  

 Delete files – Deleting data with Windows running from the system drive can 
be unreliable, especially if the Volume Shadow Copy is running in the 
background. Volume Shadow Copy service may still be active, keeping the 
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previous version of the file or even a snapshot of the whole disk. With this in 
mind, an intruder might try and retrieve your confidential data. By deleting 
your files using the other operating system from an external drive, you can 
rest assure that the deletion is permanent.  

 

Active@ Boot Disk contains the following products and utilities:  

 Active@ Disk Image  

 Active@ Data CD/DVD Burner 

 Active@ Partition Recovery 

 Active@ File Recovery  

 Active@ Password Changer  

 Active@ Disk Editor 

 Active@ KillDisk  

 Active@ Partition Manager 

 Active@ BCD Editor 

 Network operations utilities to help you map network drives, view network 
status, configure IP settings and Windows firewall and to help you connect 
and work with a server remotely 

 Utilities to monitor the status of your hard disk, copy, move and delete files 
and folders, extract compressed archives, create text files, preview an image 
or graphics and search for and display registry details 

 System utilities to create, delete, format and resize partitions, manage 
system tasks, run command prompt commands, check disk integrity and 
defragment volumes, display system information, configure the display 
parameters and edit system boot configuration. 

 Internet tools: Internet browser and Mail Sender 

 Console Tools: Command Prompt, DiskPart, DiskRAID, FTP Clients 

 Professional Tools: PowerShell, BitLocker Manager & Repair tool, iSCSI 
Manager, SSH & Telnet clients 

 A list of documents that support Boot Disk utilities. 
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1.1.1 About Active@ Boot Disk operating system 

Because the Active@ Boot Disk ISO image has been created using the Microsoft 
Windows PE (Pre-installation Environment) operating system, you have access to many 
new Windows 11 (24H2 code base) features.  

Active@ Boot Disk can be targeted for different platforms: 

 64-bit Intel or AMD processor (x64 or amd64 architecture) 

 64-bit Snapdragon processor (arm64 architecture) 

The bootable image contains a variety of plug-ins, drivers and other 64-bit applications.  

Here are some features of Windows PE: 

 You can use the new Windows 11 style standard dialogs, like File Open, Save 
As, and so on. 

 PnP (Plug and Play) support: Hardware devices can be detected and installed 
while Windows PE is running. This supports any in-box PnP device, including 
removable media and mass-storage devices. This means that you can plug in 
a mass-storage device to use for data recovery or data backup. 

 Automatic writable RAM volume: When booting from the CD/DVD drive, 
Windows PE automatically creates a writable RAM disk (drive X:) and 
allocates 512 MB of the RAM disk for general-purpose storage. By using 
compressed NTFS, the 512 MB is addressable up to almost 1GB. This drive 
space may be used to recover files or folders. 

Note  There are two Active@ Boot Disk packages being distributed. One is a 
public evaluation DEMO that can be also activated with a registration key. 
DEMO package contains a standard WinPE 11 set of packages. This is a 
minimal size configuration. Another package has been supplied to clients 
after purchasing a registration key. This full package contains  additional 
packages installed: WinPE-NetFX (.NET Framework), WinPE-Dot3Svc 
(IEEE 802.X authentication protocol on wired networks), WinPE-RNDIS 
(network support for devices that implement the Remote NDIS 
specification over USB), WinPE-PowerShell (PowerShell console), WinPE-
StorageWMI (PowerShell cmdlets for storage management), WinPE-
Scripting (multiple-language scripting environment for automating system 
administration tasks, such as batch file processing), WinPE-WMI (subset 
of the Windows Management Instrumentation providers that enable 
minimal system diagnostics), WinPE-SecureStartup (provisioning and 
management of BitLocker and the Trusted Platform Module - TPM), 
WinPE-EnhancedStorage (enables Windows to discover additional 
functionality for storage devices, such as encrypted drives, and 
implementations that combine Trusted Computing Group (TCG) and IEEE 
1667) . It requires ~150MB more disk storage space and consumes 
~150MB more RAM when boot up than the smaller package. 
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Note  After the Windows PE operating system and Active@ Boot Disk have 
started, the boot CD/DVD can be removed from the drive. A new CD/DVD 
can be inserted into the drive and you can read from it or burn data to it. 

 

1.2 Requirements for Using Active@ Boot Disk 

To use Active@ Boot Disk, you must have the following: 

 64-bit Intel or AMD processor (x64 or amd64 architecture) 

 64-bit Snapdragon processor (arm64 architecture) 

 1GB or more RAM 

 A CD/DVD/Blu-ray drive or a USB mass storage device to boot from 

In addition to the above, you must be able to start the computer and you must have 
access to the system board BIOS/UEFI setup to specify bootable device. 
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1.2.1 How the system RAM is used 

The ISO for Active@ Boot Disk was created from Windows PE (Pre-installation 
Environment), a lighter version of Windows 11. 

When booting from the CD/DVD drive or from a USB storage device, Windows PE 
creates a writable RAM volume (X:) and places itself in this drive for loading. While 
Windows is booting up, it loads itself into RAM. After Windows has started, the boot 
CD/DVD may be removed from the drive or the USB flash card may be removed from 
the USB port. Starting with 1GB of RAM, all that is left is about 500MB of available space 
to work with. 

 

1.3 Downloading and Creating Active@ Boot Disk 

You must perform these operations on a separate computer with a healthy hard drive 
and access to the Internet. 

To download Active@ Boot Disk: 

 Open your browser and navigate to http://www.boot-disk.com 

 You can download either package for Intel/AMD processor (x64/amd64) or 
package for Snapdragon processor (arm64) 

 To download the evaluation Demo version, click the Download link. 

 To download fully featured Active@ Boot Disk, click the Buy Now! link and 
follow the procedure for paying. 

 You can save the file to a folder on your machine or you can run it directly 
from the Internet folder. 

 Run the installation executable and the install wizard will lead you through 
pages in order to agree with the terms of the license and determine the 
destination folder. 

 In the Select Components page, for assistance with writing Active@ Boot 
Disk to a bootable CD, DVD or USB mass storage device, select the Active@ 
Boot Disk Creator check box. 

 After Active@ Boot Disk has been successfully installed, select the Run 
Active@ Boot Disk Creator check box and click Finish.  

 

Continue with the next section. 

http://www.boot-disk.com/
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1.3.1 Active@ Boot Disk Creator 

Active@ Boot Disk Creator helps you prepare a bootable CD/DVD/Blu-ray disc, ready-to-
go ISO image or USB Flash mass storage device that you can use to start a machine 
with a damaged hard drive and recover data, recover partitions, wipe or erase data, 
create a disk image or repair security access issues. 

To prepare a bootable device for Windows: 

1. In the Active@ Boot Disk Creator main page, select the desired bootable media: 
CD/DVD/Blu-ray, USB Flash Drive or pre-configured ISO Image file (can be used 
with Virtual Machines like VMWare or Hyper-V, or can be burned to CD/DVD/BD 
later on):  

 

 If more than one CD/DVD burners exists, or several USB disks are inserted, 
select a proper device from a combo-box. If your USB Disk is not displayed in 
a combo-box, click the link below and initialize it properly.  If you have 
purchased commercial version of Active@ Boot Disk, click Registration link 
to register software on your name or on the name of your business. 
Registration eliminates DEMO version limitations and activates all features of 
commercial software. 
Click Next. 
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 Make sure that Windows-based Boot Disk checkbox is selected 

 Select proper platform (Intel/AMD or Snapdragon) to prepare boot disk for 

At this step you can specify additional options: 

a. To specify additional boot options, click System Boot Settings tab. You 
can change default settings to be used: Time Zone, Additional 
Language Support, Display Resolution and Scale, Default 
Application Start and Auto-start Delay.  
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b. Two additional second level tabs:  

a. Network tab allows you to pre-define Network Settings: network 
initialization, dynamic or static IP configuration and firewall state. 
Subtab Network Resource allows mapping a network resource 
to a volume letter to be able to export reports and other data. 

b. Security tab allows you to set up a Boot Disk password 
protection for boot up process to avoid unauthorized Boot Disk 
usage. 

c. To add your custom files to bootable media, click User’s Files tab. Add 
files or folders using related buttons at the right side. Added items will be 
placed to User_Files root folder. 

d. To add specific drivers to be loaded automatically, click Add Drivers tab. 
Add all files for the particular driver (*.INF, *.SYS, …). Added items will 
be placed into BootDisk_Drivers root folder. At boot time all *.INF files 
located in this folder will be installed. 

e. To add specific scripts that will be launched after Active@ Boot Disk is 
loaded, click Startup Scripts tab, add your scripts (*.CMD files). Added 
files will be placed in BootDisk_Scripts root folder. At boot time all 
*.CMD files located in this folder will be executed. 

f. To specify default application startup parameters, click Application 
Startup tab and type command line parameters. Note, that this tab will 
be enabled only after you define Default Application to be started at 
System Boot Settings tab. 

g. To configure access to clouds for applications that use Cloud Services (like 
Active@ Disk Image), click Cloud Settings tab and type all related info. 

h. To configure settings for particular applications, click App Config tab and 
type all related info. Sub tabs let you select the particular product. 

Settings accessible for Active@ KillDisk: 

- Settings file path – local/network path to a pre-configured 
settings.xml file to be used as current settings 

- Digital signature path – local/network path to *.pfx file to be used 
for digital signing erase certificates 

- Logo file path – local/network path to company’s logo image file to 
be used  for erase certificates 

- Volume label to store reports – local or network attached volume 
(logical disk) with particular name, where certificates/events/reports 
will be stored after erase is complete 

- Mapped network resource to store reports – if network resource 
has been configured and mapped to a drive letter, it can be used to 
store all reports/logs/certificates  

 

Most of these options you can change later, after booting from Active@ 
Boot Disk drive, at the opening screen. Since Active@ Boot Disk is comes 
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with other LSoft’s application, Default Application option allows you to 
skip launching that default application particular.  This is also applicable in 
other Active@ Boot Disk Lite versions being distributed in other Active@ 
software products, like Active@ KillDisk for example.  

 

 Click Next. Verify the Selected Media, Sizes and Boot-up Environment. 

 If you prepare Active@ Boot Disk WIM image for use with PXE Boot, click 
Save button store your custom configuration. Place saved files to the root 
folder of WIM using DISM utility from Microsoft ADK. 

 Click Create. A progress bar appears while media is being prepared. 

Note  USB Drive or blank CD/DVD must be inserted and chosen explicitly on the 
first step, before you can proceed to the next step. 

Note  When you prepare USB Flash Drive bootable media, it will be re-
formatted, thus all data stored on the media will be erased. If your USB 
Disk is not displayed in a combo-box, click the link below and initialize it 
properly. The only 32GB or less size partitions supported (for best 
compatibility with all types of BIOS & UEFI Secure Boot systems), so if 
you have 64GB USB, initialize it with the only 32GB partition. 

Note  If you’ve created ISO Image file, you can burn it up later on, either 
using our free Active@ ISO Burner utility (www.ntfs.com/iso-burning.htm), 
or have a disk burning utility that you prefer to use. 

 

1.4 BootDisk_Drivers and BootDisk_Scripts 

You can automate some functions using Active@ Boot Disk.  

While Active@ Boot Disk is starting, you may install drivers and run scripts in order to 
reduce the amount of time required to perform maintenance functions on your data 
storage system. 

If you know that your hard drive has damaged drivers, or if you have older or 
uncommon RAID type or SCSI type drivers, you can create a folder named 
BootDisk_Drivers in the root of any logical drive and load drivers along with their 
configuration files into it. Active@ Boot Disk will detect these drivers and install them 
automatically during the boot process.  

While Active@ Boot Disk is loading (described in the next section, below), the utility 
searches for the BootDisk_Drivers folder in the root of all devices. That includes the 
floppy drive, a USB device, a working hard drive, and so on. 

If Active@ Boot Disk finds .INF files inside a folder named BootDisk_Drivers, it tries to 
load them along with all other files required by the drivers.  

https://learn.microsoft.com/en-us/windows-hardware/manufacture/desktop/mount-and-modify-a-windows-image-using-dism?view=windows-11
http://www.ntfs.com/iso-burning.htm
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Whether or not the utility loads drivers, Active@ Boot Disk will proceed in search of a 
folder named BootDisk_Scripts – again in the root of any logical drive. Active@ Boot 
Disk will run any CMD files, assuming that they are scripts. 

Active@ Boot Disk Creator helps you in configuring these folders. 

 

Note  Active@ Boot Disk Lite version (included in other Active@ software 
packages, like Active@ KillDisk) launches a primary application by default 
without any command line parameters. If you need to configure a default 
application to be run with some command line parameters, you need to 
create a proper script and place it in the BootDisk_Scripts folder. In 
this case we recommend you to turn off default application launch (Boot 
Settings tab in Boot Disk Creator) to avoid two copies of software being 
launched after boot disk start up at the same time. 

 

1.5 Booting from a CD, DVD or USB Device 

You can start your computer and perform data recovery and other functions by starting 
from a bootable CD, DVD or USB device. 

To start your computer with the Active@ Boot Disk CD, DVD or USB device, you must 
first download the ISO file and burn it to the medium. 

Before you use Active@ Boot Disk, you must purchase it and obtain a registration key, 
or use supplied evaluation DEMO key. 

 

Note  For instructions on setting boot sequence priority in the system BIOS, see 
Chapter 4: About Boot Priority. 

 

To boot from the Active@ Boot Disk device: 

1. To boot from a CD or DVD, put the bootable Active@ Boot Disk CD or DVD disk 
into the player. 

 To boot from a USB device, plug the bootable Active@ Boot Disk USB 
device into a USB port. 

 Start the power on the machine. In a black text-mode screen, the following 
message appears: 

Press any key to skip loading Active@ Boot Disk... 

 If you want to cancel booting up the Active@ Boot Disk and load the 
operating system on the hard drive, press a key on the keyboard. Otherwise 
the screen will change and loading of the kernel will appear. 
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 After the Windows PE start screen, the screen will go dark for a period of 
time. Wait for the start page to load.  

 The Active@ Boot Disk start page appears.  

 

 If you stay idle on this page, after the 30-second progress bar completes, 
Active@ Boot Disk will automatically continue. 

 On this page you can change and add these features: 

a. Add a second language keyboard layout- select the Additional 
Keyboard layout check box and choose the language from the 
Keyboard layout to install drop-down list. 

b. Change local time zone- choose the time zone from the Time zone 
drop-down list. 

c. Change screen resolution- choose a setting from the Screen 
resolution drop-down list. 

d. Initialize your network card and allow a network connection, select 
the Initialize network interface check box. 

e. Click OK. 

 

The console will detect and load hardware drivers and start the network connection (if 
you have initialized the network interface). This may take a long time and the screen 
may have black flashes. 

 

 The Active@ Boot Disk taskbar appears.  
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You are ready to use the utilities in Active@ Boot Disk. 

After starting the computer this way, you will have full and exclusive access to the 
system drive. With this kind of access, you can perform tasks that are not possible when 
Windows has been booted regularly from the hard drive.  

The only other way to get this type of exclusive access to your hard drive would be to 
physically remove it and install it on another computer.  

Note  You cannot save registration information to a file on a hard drive with 
damaged partitions. 

Note  If you have successfully booted from the CD, DVD or USB device and you 
do not see your C: drive because, for example, it is a Stripe Array (RAID0) 
or if you are using an older or non-standard controller, see instructions in 
Start > Load Driver.  
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2 Navigating the Active@ Boot Disk Shell 

The Active@ Boot Disk shell works in a way that is similar to the Microsoft’s Windows 
shell. The main interface of the shell appears as a taskbar at the bottom of the screen.  

As in Windows, Start button, with the Active@ symbol on it, can be found in the bottom 
left corner. Several quick launch icons are placed on the right of the Start button. 

2.1 Start button menu 
 

 

  
 

The Active@ Boot Disk Start button is the central launching point for applications, 
utilities and support documentation. To access one of the applications or utilities, click 
the Start button. A menu will appear containing shortcuts to applications, utilities and 
documentation under the following headings: 

 Programs – Data backup, data recovery and data security programs that allow 
you to: 

 Back up or restore physical and logical hard drives, including folders, data 
files and installed applications. Use an ISO disk image or burn files to a CD or 
DVD. Protect your valuable data by regularly making backups. 

 Recover files from deleted or damaged partitions on attached or external 
drives, portable drives and memory cards.  

 Recover deleted or damaged partitions and volumes.  

 Reset password and user accounts on your system.  

 View and edit disk sector content in raw format. 

 Securely erase data from hard drives in a way that it is impossible to restore 
the data.  
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 Wipe data from unused clusters on a regular basis to make your drive's 
deleted or temporary data unavailable to intruders. 

 Monitor the reliability status of your local hard drives to help prevent data 
loss due to hard drive failure. 

 Network – Network operations utilities to map network drives, view network 
status, renew your computer IP address or connect to a remote desktop  

 Utilities – Monitor the physical status of your hard drives, create, delete and 
format drive partitions; copy move and delete files and folders and edit registry 
parameters. Search for and display registry details. Also make calculations, notes 
and graphics about actions that you have done or need to do 

 System – Run system utilities like Windows Task Manager, Partition Manager 
and Check Disk. Run commands in a DOS environment. View & edit BCD 
(Bootable Configuration Data) entries. Allow menus and dialogs to display in local 
languages and change the keyboard layout. Also, display system information, 
change the display resolution and scale 

 Internet – Run Internet browser and send emails 

 Console Tools – Run command line tools, like Command Prompt, DiskPart, FTP 
Client, Telnet and more 

 Documentation – Documents included with Active@ Boot Disk 

 User Programs – Shortcuts created by users will be placed here as well as on a 
Desktop. If you store customized configuration to the USB disk while shutting 
down the system, the configuration will be restored when your next boot 
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2.1.1 Other start button features 

 

Start > About Boot Disk 

To get information about your purchased license or the status of your DEMO install, click 
Start > About Boot Disk. 

 

Start > Run 

Use Run to launch a program from a command line. 

 

 

 

To start a program using Run: 

1. Click Start > Run. The Run dialog box appears. 

2. In Open, type the path to the program you want to open, or click Browse to 
locate it.  

3. Click OK. 

The Open drop-down list displays programs you have opened recently.  

 

Start > Load Driver 

Load Driver will help if you have SCSI drive controllers or an older or uncommon RAID 
type device. Load Driver will also help if you cannot find any other type of driver, for 
example, video driver, sound card driver, etc. 

To load a driver: 

1. Click Start > Load Driver. The Active@ Driver Installer dialog box appears.  

 In INF Path, enter the path to the driver information file or click Browse to 
locate it. 

 Click INSTALL DRIVER! 

After the driver is installed, you should be able to locate the driver using Utilities > 
Explore My Computer. Similarly, the system should be able to locate and use the driver. 

Note  If you do not have the driver information file on the current drive, do one 
of the following: 
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 Load a CD or DVD disk with the correct drivers into the CD/DVD drive 
or plug a USB device with the correct drivers into a USB port. 

 Close Active@ Driver Installer. Use Internet Browser or another 
Internet utility to download the driver from an Internet URL and save it 
to your hard drive. Start this procedure again at step 1. 

Note  You can load drivers automatically at boot time. For more information, 
see 1.4 BootDisk_Drivers and BootDisk_Scripts. 

 

Start > Turn Off Computer 

When you turn off the Active@ Boot Disk shell, you have the option to shut down your 
computer, restart it or cancel the exit routine. 

 

2.2 Quick launch icons 

Several permanent icons appear to the right of the Active@ Boot Disk start button. To 
see a “hover box” with additional information about a quick launch icon, hold your 
mouse pointer over the icon.  

 

Use these icons to conveniently open the following programs: 

 Active@ Disk Image 

 Active@ File Recovery 

 Active@ Partition Recovery 

 Active@ Password Changer 

 Active@ Partition Manager 

 Active@ Disk Editor 

 Active@ KillDisk 

 Active@ Data CD/DVD Burner 

 Active@ Disk Monitor 

Note  To allow the taskbar to hide automatically, click the lock icon to 
unlock it. The taskbar hides until you hold the mouse pointer over the 
bottom of the screen. To lock the taskbar in place, click the lock icon to 
lock it. 
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2.3 System utility icons 

At the bottom right corner of the taskbar, a system tray is placed with a clock showing 
the system time and date.  

 

As well, several icons provide quick access to system utilities. To see a “hover box” with 
additional information about a system utility icon, hold the mouse pointer over one of 
the icons. 

Use these icons to conveniently open these utilities: 

 Set Date, Time & Zone (You may also double-click the clock.) 

 Display Settings 

 Task Manager 

 Explore My Computer 

 Screenshot utility 

If a network is installed, the Network connection icon displays full configuration details 
such as operational status, IP address, DNS server address, firewall status, and so on. 

If a second language is installed, the current language is displayed, along with a hint 
about how to change the active language.  

After you have successfully started Active@ Boot Disk, click Utilities > Explore My 
Computer. The Boot Disk Explorer will appear. You should see all the physical and 
logical devices associated with your computer along with the RAM drive Boot (X:). 

 

Display Settings 

This utility allows to change current Display Resolution and Scale to provide better 
desktop look and feel. 

 

To change Display Settings: 

1. Select desired resolution in the List of valid modes and click Apply. 

2. Select desired Scale in the list of Scale options and click Set. 
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In seconds display should be resized to accommodate new parameters. If for some 
reason Windows was unable to change resolution or scale, previous mode will be 
restored. 

Screenshot 

This utility is an easy-to-use, flexible way to take a snapshot of on-screen details in the 
Active@ Boot Disk environment. 

 

 

 

To use Screenshot: 

 Click the Screenshot icon. The Screenshot workspace will appear as a 
semi-transparent overlay. 

 Change the size and location of the workspace. The area that is covered is 
the area that will be captured. 

 When you change the size and the location of the workspace, the Top 
and Left values change to identify the location of the top left corner of 
the workspace. At the same time, the Height and Width values 
change to reflect any change in the size of the workspace. 

 To change the size of the Screenshot workspace, click and drag an 
edge or a corner of the workspace. 

 To change the location of the workspace, click anywhere on 
Screenshot and drag to a different location. 

 To fill the entire screen, click Maximize. 

 With the Screenshot workspace in place, you can return to the original 
application using ALT+TAB keyboard combination.  

 You can also click the original application to return to it, however if you 
click an area of the application that is covered by the Screenshot 
workspace, the focus will return to Screenshot. 

 To capture the screen image, in Screenshot, click Grab and a semi-
transparent image of the screen will appear on the desktop 

 To clear the existing screen image, click Clear. 
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 To save the screen image, click Save and navigate to the folder where you 
want to save the image. You can save the image as PNG or BMP 

2.4 Desktop Shortcuts and User Programs menu 

 

Active@ Boot Disk allows to customize the user interface. You can create shortcuts for 
the additional portable user’s tools on the Desktop and in the Start menu the same way 
as you do it in Windows Desktop environment. These shortcuts can be saved to USB 
media and restored when you boot up the system the next time even on the different PC 
configuration. You can store customized settings to USB even if you boot from CD/DVD. 

 

To create a Shortcut: 

1. Right-click the Desktop and click Create Shortcut context menu item 

2. Select path to the application executable in the Path: field and type shortcut title 
in the Description: area 

3. Select where you want shortcut to be stored:  

a. on the Desktop 

b. in the User Programs sub-menu of Start menu 

c. in the specific folder, select full path to the desired location 

4. Click Create button 

 

 

To store customized settings including shortcuts to USB: 

1. Click Turn Off Computer from the Start menu 
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2. Select settings you want to save. Settings not being changed are grayed out 

3. Select USB volume to save settings to 

 

4. Click Save button and proceed with Shut Down or system Reboot 
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3 Programs and utilities 

This chapter provides detailed descriptions of all the programs and utilities included with 
Active@ Boot Disk. 

Applications are listed in this chapter in the order that they appear in the Active@ Boot 
Disk start menu. 

 

3.1 Programs 

3.1.1 Active@ Disk Image - Create an exact image of the data stored in selected 
partitions of a hard disk or an image of the entire hard disk. 

3.1.2 Active@ Data CD/DVD Burner - Write/burn files and folders onto CD-R, DVD-
R, DVD+R, CD-RW, DVD-RW, and DVD+RW. 

3.1.3 Active@ Partition Recovery - Recover deleted or damaged partitions located 
on data volumes, attached hard drives, as well as on external USB drives and Memory 
Cards (SunDisk, MemoryStick, CompactFlash, etc.).  

3.1.4 Active@ File Recovery - Recover files that have been damaged, destroyed by a 
virus or if the file directory has been destroyed. 

3.1.5 Active@ Disk Editor - Edit disk’s raw data to analyze and repair the MBR 
(Master Boot Record) and other important files. Advanced search capabilities and 
templates for viewing MBR, Boot Sectors, LDM, MFT records are available 

3.1.6 Active@ Password Changer - Recover user accounts with forgotten or 
damaged user passwords.  

3.1.7 Active@ KillDisk - Destroy data permanently from any computer. Also, wipe 
deleted data, securely removing all data in unoccupied sectors  

3.1.8 Active@ Partition Manager - Perform maintenance tasks on hard drive 
partitions. 

3.1.9 Active@ Disk Monitor - Monitor the reliability status of your local hard disk 
drives to help prevent data loss due to hard drive failure. 
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3.1.1 Active@ Disk Image 

 

Active@ Disk Image is a Windows-based solution that allows you to create an exact 
image of the data stored in selected partitions of a hard disk or an image of the entire 
hard disk. You can protect your valuable data by regularly making a disk image and 
keeping it in a safe place. If you have trouble with data corruption, or if you want to 
refer to an archived version of a file, you can easily restore the data. 

The application provides many tools when it comes to backing up data on your hard 
disk: 

 Disk to Image – Choosing this option will open the Disk to Image Wizard. It will 
help you in creating a regular type of the disk image archive of an entire disk or 
of selected partitions in the system.  

 Image to Disk – This option features Image to Disk Wizard which will enable you 
to restore data from a disk image archive that you have previously created.  

 Explore Image – Enables you to browse through files and folders in a disk image 
as though it was a hard drive. You can select folders or individual files and 
restore them.  

 Verify Image - Verify Image Wizard is there to checking the integrity of the disk 
image archive file.  

 Create Raw Image – with its Create Raw Image Wizard this application will guide 
you in creating a raw type disk image of only one partition or the entire disk.  

 Clone Disk – Enables you in transfering a sector-by-sector copy from one disk 
(partition) to another.   

 Partition Manager – A tool that helps you create, delete, format or show 
properties of partitions on all devices in your system. 

 

This guide describes only the Disk to Image tool. For a description of the other tools, 
see the Active@ Disk Image User’s Guide document in the Documentation tab of the 
Active@ Boot Disk shell. 

Creating a Disk or Partition Image 

The Disk to Image Wizard steps you through the process of creating a disk image for a 
whole disk or a number of partitions. 

To create a disk or partition image: 

1. To open Active@ Disk Image, in the Active@ Boot Disk shell, click Start > 
Programs > Active@ Disk Image. 

 To open the Disk to Image Wizard, in the Disk Operations Panel, choose Disk 
to Image.  
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 The wizard will ask you to choose one from three available backup types 

 

 Full Backup- represents an ordinary backup. If this is your first backup it 
doesn’t matter which option you choose, the first backup is always Full 
Backup. 

 Incremental Backup- it’s made out of Full Backup and other incremental 
backups. It contains differences and changes between these two backups, 
and the main characteristic of the Incremental Backup is that it doesn’t 
require a lot of space but it does require the information from all of the 
previous incremental backups in order to be functional. 

 Differential Backup- requires only the first (Full Backup) and the last backup. 
There is no difference between Incremental and Differential backups if they 
only have two backups (Full Backup+ another backup), the difference 
becomes noticeable over longer periods of time when Incremental backup 
generates more of its backups. 

 Click Next, which will open Select Disks and Partitions window. 
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 Select a check box next to a disk or partition that you want to be included in 
the disk image. You can see at the bottom of the list the total size for the 
selected partitions being displayed. 

 Click Next and the Indicate Backup Location page will appear. 

 

 Do the following: 

 If a CD/DVD burner is available, select the CD/DVD radio button, select 
a device from the Device drop-down list and type an appropriate disk 
image name into the Backup name field.  

 To save the disk image to a hard disk, select the Local or network 
file radio button and click Browse... and navigate to the location 
where you want to save the disk image. 

 Click Next. The Image Options page appears. 
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 Do the following: 

 To set the compression ratio, select one of the three options:  

- None give you fast results and a larger file size.  

- Normal (recommended) is a compromise between a smaller file 
size and a faster operation speed.  

- High provides the smallest file size and takes the longest time to 
complete. 

 To try saving the disk image to a single file, in the Image Splitting 
area, select the Automatic (try single file) option. If the system 
runs out of free disk space on the disk where you are saving the 
backup - or if you are storing an image file on disk with a FAT file 
system - Active@ Disk Image automatically will split the archive into 
multiple files and prompt you to add another path in order to continue 
writing the rest of the file. 

 To manually indicate how to split the disk image, in the Image Splitting 
area, select the Fixed size (MB) option and type a file size in 
megabytes or choose a size from the drop-down list. 

 To protect sensitive data on a disk image, in Password, type a 
password (maximum 16 characters) and type the same password in 
Confirm.  

 Optionally, type a short description of your disk image (maximum 
1,024 characters) into the Image description text box.  

 Click Next, which will take you to Create Another window. Active@ Disk 
Image also supports creating of multiple image files simultaneously: 

 To create an additional image file check Yes, create another 
image. This will open another wizard where you will need to choose 
the settings (select Backup type, choose drive and partitions, etc ) 
for this image file from the beginning. 



 

  29 

 In order to create Raw image check Yes, create another Raw 
image. New wizard will start asking you pick the drive you want 
backup in Raw Image format. Later you will need to choose Backup 
location, set Image options, etc. Basically you will need to repeat 
previously explained steps (5-8) 

 If you do not want to create any additional images you just click 
Next, since No, Proceed to confirmation is selected by default. 

 After clicking on Next the Confirm Operation Details page will show up. 

 

 Do the following: 

 Review the details in the summary.  

 Verify after creating is checked as default.  

 Shut down when finished- choose this option if you plan to create 
an image during the night or while you are away 

 Minimize in tray- checking this will minimize Active@ Disk Image in 
system tray, freeing your Taskbar and Desktop 

 By clicking on Next you will initialize the image file creation and open the 
Progress Status page. 
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 To stop the operation at any time, click Cancel. 

Note  The compression ratio and the compression speed depend on multiple 
factors. For example, .doc files under the Normal Compression can be 
reduced to up to 80% and up to 90% with High Compression. On the 
other hand image (f.e. jpegs) files are not compressible, while .exe files 
can be reduced by 40%-50% in Normal Compression and 50%-60% in 
High Compression. 

 Compression speed can vary a lot depending on how fast your CPU is, 
how fast is the drive whose image you are making and how fast is the 
disk where you will be storing that particular image. We recommend that 
you stick with Normal compression since it has the best performance 
ratio. It is not as slow as the High Compression (it’s around x1.5-x2 
faster) and it has a slightly lesser compression result (around 10% less). 

Note  For more detailed instructions and support, see the Active@ Disk Image 
User Guide. 
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3.1.2 Active@ Data CD/DVD Burner 

To use Active@ Data CD/DVD Burner: 

1. From the Active@ Boot Disk shell, click Start > Programs > Active@ Data 
CD/DVD Burner. This will open Active@ Data CD/DVD Burner dialog box. 

 

 Place a writable CD/DVD in the drive. 

 To add a file or a folder just right drag & drop the file into the Base field. Or 
you can right click on the base field and choose the Add file or Add folder 
data type and continue browsing from there. 

  When you find the file or folder you are looking for, select it and click Open. 
The name of the selected file or folder will appear in the Base area. When 
browsing you can select multiple files from the same folder and add them to 
the Root list. 

 To remove an item from the Root list, right click on it and choose Delete. 
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 To label the CD/DVD, type a descriptive label in Disc Label. 

 Select a drive and a write speed from the Burner drop-down list. 

 Click BURN DATA! 

 

Files are written to the CD/DVD. 

Note  For more detailed instructions and support, see the Active@ CD/DVD 
Burner User Guide 

 



 

  33 

3.1.3 Active@ Partition Recovery 

 

Active@ Partition Recovery is a data recovery utility that you can use to: 

 Find and recover deleted partitions and logical drives 

 Last Chance - if all recovery methods fail, you can still try to save individual 
files on your deleted partition. 

 Create a Drive Image for backup purposes  

 Fix or create a typical MBR (Master Boot Record)   

This means that you can recover deleted or damaged partitions located on data volumes 
(D:, E:, and so on), attached hard drives, as well as on the external USB drives and 
Memory Cards (SunDisk, MemoryStick, CompactFlash, etc.). On a system partition, 
BOOT.INI is corrected automatically (if needed) to repair an un-bootable system. As 
well, damaged Volume Boot Sectors are corrected to maintain integrity of the partition. 
This utility also enables you to fix a damaged MBR and to delete invalid partitions. 

For any computer to boot properly, the following conditions must apply:  

 The MBR (Master Boot Record) exists and it is not damaged in any way  

 The Partition Table exists and contains at least one active partition  

If these conditions exist, the executable code in the MBR selects an active partition and 
passes control to it so that it can start loading the system files (COMMAND.COM, NTLDR, 
BOOTMGR,... ).  

If these files are missing or are corrupted then the operating system will not boot. 

Data Recovery Tips 

DO NOT WRITE ANYTHING ON THE DRIVE THAT CONTAINS YOUR IMPORTANT 
DELETED DATA!  

When you install software, you write data on the disk. This can destroy your deleted 
data. If you have only one logical drive, physically remove the hard drive from the 
computer and install it as a second logical drive on another computer where data 
recovery may be possible. 

DO NOT SAVE RECOVERED DATA ON THE SAME DRIVE THAT CONTAINS THE LOST OR 
DAMAGED DATA!  

When saving recovered data, you are writing records to the file table. If you write these 
records to the same drive that contains the damaged data, you are destroying the file 
table records that you are trying to recover. At the same time, you may be destroying 
the file table records for other deleted entries. It is best to save recovered data onto 
another logical, removable or network drive. 

CREATE A RAW DISK IMAGE IF YOU HAVE AN EXTRA HARD DRIVE, OR OTHER 
LOGICAL DRIVES THAT ARE BIG ENOUGH!  

A Raw Disk Image is a single file that stores all the data from your logical drive or 
physical device as a mirror image. Having a Raw Disk Image can be useful when you 
want to back up the contents of the whole drive, and restore it or work with it later. 
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Before you start recovering deleted files, it may be a good idea to create a Raw Disk 
Image for the one drive, if you have enough space on another drive. If you do 
something wrong while recovering the files (for example, recovering them onto the 
same drive and destroying the data), you will be able to recover these deleted files and 
folders from the Raw Disk Image that you have wisely created in advance. 

 

Find and recover deleted partitions and logical drives 

To find and recover deleted partitions and logical drives: 

1. From the Active@ Boot Disk shell, click Start > Programs > Active@ Partition 
Recovery. The Active@ Partition Recovery workspace appears with all available 
devices listed in a tree view under Local System Devices. 

 

 To scan an unallocated space, select it. Known details of the selected item 
are displayed in the right pane. 

 To scan the unallocated space in basic mode, click Quick Scan, the process 
will start and the status bar will display the scan progress. After the scan is 
complete, a list of all allocated and unallocated partitions will appear in the 
Local System Devices list. 

 If you cannot see a logical drive, you will need to process the whole surface 
of a disk, select it and right click on it and click Super Scan.  
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 When the Super Scan Options dialog box appears, do the following: 

To restrict the scan to a small number of sectors, indicate the From sector 
and the number of sectors to scan. If you are unsure about any of this, just 
ignore this step and click on Scan. 

You can follow the  scanning progress via status bar 

 

After the scan is complete, a new folder named SuperScan will be created 
in the Local System Devices list.  

 To display a smaller set of SuperScan results, do the following: 

a.  Right-click the SuperScan device node folder.  

b.  From the context menu choose Filter... This will open the Filter 
Found Partitions dialog box.  
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c. Scanning for all supported file types is on by default. If there are 
particular file types that you do not want to be displayed clear the 
check boxes besides them.  

d. To display only those partitions within a specified size limit, in the 
Partition Size area, indicate the minimum and maximum size of 
partitions in Megabytes. 

e. To use basic filtering parameters, in the Filter Type area, click Use 
Basic Filtering. 

f. To select displayed partitions based on partition status, in the Basic 
Filtering [Partition Status] area, clear the check box next to each 
partition status number that you do not want to display. 

g. To use advanced filtering parameters, in the Filter Type area, click Use 
Advanced Filtering.  

h. To restrict displayed results for NTFS-specific parameters, in the 
Advanced Filtering [NTFS specific] area, select the check box 
beside all the types of data that you want to display 

i. To restrict displayed results for FAT-specific parameters, in the 
Advanced Filtering [FAT specific] area, select the check box 
beside all the types of data that you want to display. 

j. Click Filter. The right panel will display the filtered results. 

 In order to recover your partition you will need to click on the SuperScan 
folder in Local System Devices, this will show the SuperScan results in the 
right pane.  

 If you didn’t do anything with the unallocated space after you deleted the 
partition, chances are pretty good of recovering it. 
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a. To ensure that the Windows operating system assigns the correct letter 
to the disk, select a disk letter from the Assign Disk Letter drop-down 
list. 

b. To set the recovered partition as active and allow the system to boot 
from it, select the Set Partition Active check box. 

c. The recovery process checks the boot sector and fixes it if it is damaged. 
Select Automatic or Manual, depending on how you want to do this. 

d. If the disk has an extended partition, select the Create Extended 
Partition First check box and/or use ALL Unallocated area check 
box. If these areas are not available, these check boxes will be disabled. 

e. To save a copy of the partitioning information before recovering, select 
the Backup Current Partitioning Info check box and indicate the file 
name to store the backup. 

f. Click Recover. 

 

The partition is recovered. 

 

 You can manage other aspects of SuperScan results: 

a. To save scan results, right-click on the SuperScan folder and choose 
Save Scan Results. You can also open the saved scan results at any 
time. 

b. To delete a SuperScan folder, right-click on the folder and choose Delete. 
c. To display detailed properties of a SuperScan folder, right-click on the 

folder and choose Properties. 

 LastChance-if you were unlucky and you still didn’t manage to recover your 
partition there is still a chance to recover at least part of it. This is where 
LastChance comes into play. By simply scanning the area of the deleted 
partition you can find and recover lost files, that were presumed to be lost. In 
order to run LastChance do the following: 
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k. Click on the LastChance button in the top menu, this will open the 
LastChance wizard box 

l. Choose the device where your previously deleted partition was being 
stored 

 

 

The purpose of LastChance Recovery is to enable you to scan and recover files 
based on their signatures or by their default application. All of the supported files 
are checked by default, if you don’t require some particular file types uncheck 
them since this will greatly speed-up the process.  

 

 

 
Once you click on the Start the scanning will commence and can take to around 
a few hours. Depending on your drive size and the number of file types you 
inputted, your mileage might vary. Once the scanning starts you can pause it but 
you can’t stop it. 
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Creating a Raw Disk Image 

A Raw Disk Image is a mirror copy of your entire logical drive or physical device stored 
as set of files. It may be a good idea to create a Raw Disk Image for a drive containing 
deleted files that you want to recover, if you have enough space on another drive. If you 
do something wrong while attempting to recover a partition, you will be able to recover 
these deleted files and folders from the Raw Disk Image of that partition.  

Depending on the disk image creation settings, a Raw Disk Image consists of a 
configuration file (with an extension .DIM) and a single file chunk, or set of files having 
extensions .000, .001, .002 ... (each file chunk has a size of 2GB in this case).  

 

Important  Do not save a Raw Disk Image back onto the disk that you are 
backing up. The target location to save the Raw Disk Image must always be another 
drive. 

 

To create a Raw Disk Image:  

1. In the Active@ Partition Recovery workspace, select a logical drive or a physical 
device. Right click on it and choose Create Disk Image. Which will launch the 
dialog box. 

 In the Save In drop-down list, select another physical device or another 
logical drive.  

 Browse to the folder where you want to save the Disk Image.  

 In File Name, give the Disk Image file a descriptive name. 

 Click Save, the process will start and the progress bar will appear. 

  

Watch the progress and wait while drive's contents are copied to the new location. You 
can cancel the process of image creation anytime by clicking Stop.  

 

Fixing or creating the MBR 

The MBR (Master Boot Record) is created when you generate the first partition on a 
hard disk. It is probably the most important data structure on the disk. The MBR 
contains the partition table for the disk and a small amount of executable code. On x86-
based computers, the executable code examines the Partition Table, and identifies the 
system partition. The MBR then finds the system partition's starting location on the disk, 
and loads the copy of its Partition Boot Sector into the RAM. The MBR then transfers 
execution to executable code in the Partition Boot Sector.  

To fix or create a typical MBR: 

1. In the Active@ Partition Recovery workspace, in the Local System Devices list, 
select a disk. 

 From the Tools menu, choose Fix Boot Sector   



 

40  Active@ Boot Disk User Guide 

 Partition Boot Sector Recovery Options window is the next step in fixing your 
Boot Sector. Primary Boot Sector column (PBS) on the left must have same 
values as the Copy of Boot Sector (CBS) on the right 

 

 

The MBR is fixed. 

 

Note  For more detailed instructions and support, see the Active@ Partition 
Recovery User Guide. 
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3.1.4 Active@ File Recovery 

 

Active@ File Recovery is a data recovery utility that you can use to restore accidentally 
deleted files and folders located on the existing drives, and even on deleted or damaged 
partitions. 

It is best to save recovered data on another physical, logical, removable or network 
drive. Make sure that you have access to another physical or logical drive before 
attempting to recover a file.  

 

To run Active@ File Recovery: 

1. From the Active@ Boot Disk shell, click Start > Programs > Active@ File 
Recovery. The Active@ File Recovery workspace will show up with all 
available devices listed in a tree view under Local System Devices. 

 To scan a logical drive, select it. A message in the right pane reads Disk not 
scanned yet... 

 To scan the drive in basic mode, do the following: 

a. Click Quick Scan. The status bar will be displaying the progress of the 
scan.  

b. After the scan is complete, files and folders will be listed in the right pane. 

 

 Recovering via SuperScan- if you cannot locate or find your deleted files and 
folders, to process the whole surface of a disk, right click on it and click 
SuperScan. 

  When the SuperScan Options dialog box shows up, do the following: 
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In General tab, you can restrict the scan to a small number of sectors, 
indicate the From sector and the number of sectors to scan. Limiting the 
scan on a small area can greatly reduce the time required for scan to finish. 
Again if you are not sure about this option just leave it as is. 

You can further limit the search by focusing it on the file systems that exist 
on your deleted or damaged partitions  

 

In Signatures Recognition tab you can further specify which file types 
would you want Active@ File Recovery to search for. Thanks to in-built tools 
File Recovery can rebuild file types (DOC, JPG, DOC, ZIP, etc) from partial 
data that you really need, ignoring the irrelevant data and saving processing 
time. 

 

Click Scan. The status bar displays the progress of the scan. 
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After the scan is complete, a list of detected partitions appears in the right 
pane. You may search through these partitions. 

If you chose to re-build image files, a folder named Files Recognized by 
Signatures will be created. After the recovery you can search through the 
contents of this folder. 

 After you have scanned a drive, all you need to do now is to search for 
deleted or damaged folders or files: 

a. To search manually, click on the SuperScan result. This will show the 
scanned files in the right pane 
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 Click on the file type you are interested in and you can organize them by size 
and various other attributes such as camera model, date created, width, 
height, etc.  

a. You can also preview the scanned files by right clicking on one of them 
and choosing the Preview option 

 

b. Active@ File Recovery also supports Windows shortcuts. Meaning that you 
can select and recover multiple individual files by clicking on them and 
holding Shift or Ctrl. 

 Once you have found and selected the files you want to recover right click on 
the and choose Recover 

 

 Recovery Options window will pop up asking you to choose or confirm the 
Recovery location for your files.  
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 You can also limit the recovery on only those files that have been 
deleted.  

 If you are recovering files that have been damaged make sure to 
check Existing only check box 

 Of course, if you are trying to recover some of the files that have 
been deleted as well as some of them that have been damaged make 
sure to mark All check box 

 Do not recover your deleted files on the same hard drive where you have 
previously deleted them 

 

 For further customization click on more options… in the bottom left corner, 
this will open the Settings window.  

 

 In the General window you can choose the storage location for your 
Scan results, as well as some other options concerning scanning and your 
local devices 

 Recovery tab basically has the features from the initial Recovery 
Options window. Additionally you can automatically rename your 
recovered files be giving them a basic name and adding a number for 
each one later on. The default name is “recovered”. 

 Images tab is reserved for image creation and storing. Here you can 
designate image storage path, compression, chunk size, etc. 
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 When you are finished with changes in this window click Apply before exiting 
and you will be back to the initial Recovery Options Window 

 In the Recovery Options window click on Recovery button which will 
initiate the recover the deleted files at the location that requested. 

 Alternatively you can also use Advanced Search tool by right clicking on the 
drive that contains your deleted files, or just by selecting it and choosing 
Search in the top menu 

 New Search window will appear offering you various customization settings 

  

a. In the Find What field, enter all or part of a file or folder name. You 
can use wildcard characters to locate all files or folders that include 
that part in a name. 

b. In the File Type drop-down list, select the type of file or folder to 
search for. 

c. In the next three check boxes, you can choose to include: 

 Deleted files and folders - Select this check box to search 
through files and folders marked as deleted. If you know that the 
file or folder you are searching for has not been deleted, that is - if 
the file or folder is damaged and still exists in the file table - clear 
this check box. 

 Non-deleted files and folders - Select this check box to search 
through existing files and folders. If you know that you are 
searching for a deleted file or folder, clear this check box. 

 All files and folders - combines two previous search methods, 
enabling you to look for files and folders in different states. 

d. Case insensitive search - File Recovery will search for the Find 
What file or folder name disregarding upper or lower case letters by 
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default. In order to search for a file or folder by using the combination 
of upper and lower case letters in Find What, select this check box. 

e. To search for files or folders based on a specified date range, select 
any combination of check boxes for Created, Modified or Accessed 
(Deleted) and indicate the date range. 

f. To search for files or folders based on the size of the file, select the 
Size check box and indicate the size range. 

g. To start the search, click Find. The status bar will display the search 
in progress. 

h. After the search has been completed, a new tab named Search will 
appear in the right pane.  

i. Select a file or folder that you want to restore. 

j. Click Recover. The Recovery Options dialog box will open. 

 Do the following: 

 In the Name field, revise the file name. 

 In the Recover To field, enter a path to a drive other than the 
drive where you found this file or folder. You can also browse to 
another drive. 

 Click Recover.  

 

The file or folder is recovered to the new location. 

 

Note  A device scan or a search may take a long time. To stop a device scan or 
a search, click Stop at any time. 

Note  For more detailed instructions and support, see the Active@ File Recovery 
User Guide. 
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3.1.5 Active@ Disk Editor 

 

Active@ Disk Editor is a utility made to help you edit a disk's raw sector data. The editor 
displays information in binary and text modes at the same time. You can use this view to 
analyze the contents of data storage structure elements such as hard disks and 
partitions. 

The Open Disk dialog box displays a list of available storage devices and a list of logical 
drives.  

The Data Inspector displays whatever is currently under the cursor. It does so in ten 
different formats. This may help you interpret data as displayed in Hexadecimal View. If 
you choose to view the Data Inspector, the window will always appear docked to the left 
panel while Active@ Disk Editor.  

This section contains help with the following: 

 Starting Active@ Disk Editor 

 Changing the Workspace View 
 Navigating to Key Sectors 
 Editing Tools 
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Starting Active@ Disk Editor 

 

To start Active@ Disk Editor:  

 From the Active@ Boot Disk shell, click Start > Programs > Active@ Disk 
Editor. The Disk Editor will launch showing you first its Getting Started 
Screen. Depending on what you are looking for, you can choose to open a 
Disk, File, Disk Image or browse through your computer manually. 

 Click Open. The Active@ Disk Editor workspace will open. 

 

 To browse through the content of the opened item: 

 Click either the hexadecimal area or the text area to focus on it.   

 Use the scroll bar, keyboard arrows or the mouse wheel.  

 To toggle the focus between hexadecimal and text panes, press TAB.  

 

Changing the Workspace View 

 

When you start Active@ Disk Editor, the default view shows the Info Pane on the 
right and the editing pane on the left, with a Status Pane across the bottom. You 
may change the default configuration of the workspace so that it opens with your 
custom settings each time. 

To change Active@ Disk Editor default options: 
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1. In Active@ Disk Editor, click View toolbar button. The drop-down list 
of available views appears. 

2. You can show or hide the Templates View, Properties View, Data 
Inspector View, Bookmarks View and Find Results View at the left of the 
workspace, for example for the Templates View: 

 To hide the Templates Pane, clear the Templates check box. 

 To show the Templates Pane, select the Templates check box, or you 
can simply click on View-> Windows and click on templates 

 

3. To change the default size of the font in the editing pane, select a size 
from the Text size drop-down list. 

4. To toggle the display of the current address offset between hexadecimal 
and decimal, from the View menu, choose Hexadecimal Offset. 

 

Navigating to Key Sectors 

 

To navigate to key sectors on the open item: 

 To open a different device or logical drive: 

a. Click Open Disk from File menu, or press Ctrl+O. The Open Disk 
dialog box appears. 

b. Click a device or a logical drive to select it. Click Open.  

c. The Active@ Disk Editor workspace appears. 

 To jump to a named sector or offset: 

a. From the Navigate menu, choose Go to Offset or Go to 
Sector. The Go to Offset/Sector dialog box appears. 

b. To jump to a named offset, type the offset value as Decimal. 
Use a prefix 0x to use hexadecimal values. 

c. To jump to a named sector, in the Sector field, type the sector 
number. To jump to a named cluster, in the Cluster field, type 
the cluster number. 
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d. Click Ok. The sector/offset appears in the editing panel. 

 To jump to the volume boot sector, from the Navigate menu, choose Boot 
Sector (0). The boot sector will open. 

 To jump to the partition table, from the Navigate menu, choose Partition 
Table. The partition table sector appears in the editing panel. 

 To edit the partition table: 

a. From the Navigate menu, choose Partition Table. Navigation will 
be positioned to the sector 0, and Master Boot Record template is 
applied. The Signature (55 AA) at the end of zero sector marks the 
end of the Partition Table.  

b. Review the settings for partition table entries 1, 2, 3 and 4 in a 
Template View at the left side. 

c. Turn on edit mode (Ctrl+Alt+E) and modify partition table 
parameters. 

d. To save changes, click Save. 

 From the Navigate menu, you can jump to many named sectors. These 
sectors are listed with the sector name and a number that is unique to your 
hard drive:  

 To jump to the unallocated boot sector, from the Navigate menu, 
choose Unallocated (<your partition size>GB) > Boot Sector 
(<your sector number>).  

 To jump to various primary NTFS locations, from the Navigate menu, 
choose Primary NTFS (<your partition size> GB) and do one of 
the following: 

 To jump to the boot sector, click Boot Sector (<your 
sector number>). The primary boot sector appears in the 
editing panel. 

 To jump to the boot sector copy, click Boot Sector Copy 
(<your sector number>). The primary boot sector copy 
appears in the editing panel. 

 To jump to the MFT (Master File Table) sector, click $MFT 
(<your sector number>). The MFT sector appears in the 
editing panel.  

 To jump to the MFT mirror, click $MFT Mirror (<your 
sector number>). The MFT mirror sector appears in the 
editing panel. 

Editing tools 

 

You can paste code or text from the Windows Clipboard. Use these tools to copy and 
paste selected code.  

To use editing tools: 
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1. To toggle whether or not to allow editing in the editing pane, from the Edit menu, 
choose Allow Edit content. 

 

 To select a whole area: 

a. Click anywhere in a navigation view. 

b. From the Edit menu, choose Select All. The whole area is selected. 

 To select part of a sector, click and drag the cursor over some code. You can 
select code this way in either the HEX area or in the text area. 

 To copy HEX data, if you have already selected code in the HEX area, from 
the Edit menu, choose Copy Formatted Selected HEX data is copied to the 
Clipboard. 

 To copy text data, if you selected code in the text area, from the Edit menu, 
choose Copy. Selected text data is copied to the Clipboard. 

 To paste data from the Clipboard: 

a. Click the cursor in the area where you want to paste data. 

b. From the Edit menu, choose Paste. The data appears. 

 To discard all unsaved changes (if any were made) and roll back settings to 
the way they were at the last save, from the Edit menu, click Revert 
Changes. 

 To save changes, click Save. 
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Note  By default, you cannot edit content in Active@ Disk Editor. You must 
choose Allow Edit Content in the Edit menu in order to change the 
code. 

Note  For more detailed instructions and support, see the Active@ Disk Editor 
User Guide. 
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3.1.6 Active@ Password Changer 

 

You can use Active@ Password Changer to recover your passwords and user account 
attributes in a Windows environment.  

Active@ Password Changer is designed for resetting the local administrator password on 
Windows systems in case the administrator's password is forgotten or lost. If such turn 
of events occurs, you do not need to re-install and re-configure the operating system.  

This utility supports multiple hard disk drives, detects several SAM databases (if multiple 
operating systems were installed on one volume) and provides the opportunity to pick 
the right SAM before starting the password recovery process. It also displays a list of all 
local users.  

Other Windows login security restrictions can be reset, for example: 

 Account is disabled 

 Password never expires 

 Account is locked out 

 User Must Change Password at Next Logon 

 Logon Hours 

With Active@ Password Changer you can log in as a particular user with a blank 
password. 

 

Using Active@ Password Changer 

 

To use Active@ Password Changer: 

1. From the Active@ Boot Disk shell, click Start > Programs > Active@ Password 
Changer.  

 The Active@ Password Changer dialog box will appear. 
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 Click Next, which will open the Options window offering you to choose how 
do you want the search to be conducted. 

 

a. Search all volumes for Microsoft Security Account Manager 
Database – let  Password Changer search all of your drives in order 
to find Microsoft’s Security Data Base 

b. Select volume with Windows operating system manually- if 
want you can also search for the drive containing Windows system by 
yourself 

c. Find a folder with Windows registry files manually- if for some 
reason accessing SAM database is not possible you can find it 
manually by going to this address: 

 C:/Windows/System32/Config 

 SAM hive file should be located here 

Note  Manually copying SAM data base is possible only when the operation is 
being conducted from another operating system 
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 Select it and click Open 

 To scan the disk and detect multiple operating systems, do the following: 

a. Click Search for Search all volumes for Microsoft Security Account 
Manager 

b. Click Next. The progress bar indicates the status of scanning. A list of 
SAM hives appears.  

c. Select a database from the list. 

 

 Click Next. The list of users appears. 
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 Select a user from the list and click Next. The parameters for the selected 
user appear. 

 

 Select parameter check boxes to create the situation that you want. 

 Click Next. A confirmation dialog box appears. 

 Click Yes. An information message indicates that the changes have been 
made. 

 Click OK. 
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 For each user that you want to change, repeat steps 5 through 9. 

Note  For more detailed instructions and support, see the Active@ Password 
Changer User Guide 
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3.1.7 Active@ KillDisk 

Active@ KillDisk is a powerful utility that will:  

 Wipe confidential data from an unused space on your hard drive  

 Erase data from partitions or from an entire hard disk  

 Destroy data permanently  

Wiping the logical drive's deleted data does not delete existing files and folders. It 
processes all unoccupied drive space so that recovery of the previously deleted files 
becomes impossible. Installed applications and existing data are not touched by this 
process. Active@ KillDisk wipes unused data residue from file slack space, unused 
sectors, and unused space in MTF records or system records. 

When you erase data with Active@ KillDisk, you destroy data permanently, conforming 
to any one of six international standards or your own custom settings. 

Wiping drive space or erasing data can take a long time, so perform these operations 
when you are prepared to wait. For example, these operations may be run overnight. 

 

Using Active@ KillDisk 

 

To run Active@ KillDisk: 

From the Active@ Boot Disk shell, click Start > Programs > Active@ KillDisk. After 
initializing, the Active@ KillDisk workspace appears with all available devices listed: 
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 Click a physical drive or a logical drive to select it. Properties of the selected device will 
appear in the Properties tab docked to the right side. 

 To inspect the logical drive, select it and click File Browser toolbar button. The 
Progress tab will appear, showing the status of the scan while Time Left counts down 
the remaining time. 

 When the scan completes, sub-folders will appear in the System Local Disks 
list and the folders and files in the selected drive appear in the Folders and 
Files tab.  

 Available files and folders will appear with a colored icon, while deleted files 
and folders will appear with a gray icon. 

 After the scan has been completed, you can: 

 Inspect existing and deleted folders and files in the Folders and Files tab. 

 View sectors of data in a device or logical drive, select a device or drive and 
click Disk Viewer toolbar button. The Disk Viewer appears. Scroll through 
the available data: 

 

 View sectors of data in a file: 

a. Select a logical drive. Files and folders appear in the right panel. 

b. In the right panel, select a file. 

c. Click Hex Preview. The Data Viewer appears. Scroll through the 
available data. 

 

Wiping Data 

 

To clear data residue from unused sectors: 
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2. Select the check box next to a device or logical drive or multiple devices or logical 
drives. 

3. Click Wipe Disk toolbar button. The Wipe Disk dialog box appears:  

 

(For more about wiping methods, see Wiping or Erasing Methods of Active@ KillDisk manual) 

4. Choose one of the methods from the Erase method list. 

5. To change other parameters, like Certificate options click other tabs at the left 
side.  

6. Click Start  

7. The Confirm Action dialog box appears. Click Yes. 

8. The process will be initialized with the Progress bar appearing at the lower side 
of the left panel. 
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9. To stop the process at any time, press ESC or click at the Stop All button near 
the progress bar. You can also stop the drive wipe by pressing the little red 
square near the progress bar at Local System Devices. 

 

Erasing Data 

 

To erase data completely: 

1. Select the check box next to a device or logical drive or multiple devices or 
multiple logical drives. 

2. Click Erase Disk. The Erase Disk dialog box appears:  
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(For more about erasing methods, see Wiping or Erasing Methods, Active@ KillDisk manual) 

3. Choose a method from the Erase method list.  

4. If needed, set other erasing parameters by clicking on more options… in the 
bottom left corner.  

5. Click Start  

6. If the Skip Confirmation check box is clear, the Confirm Action dialog box will 
appear: 

 

 

 

7. This is the final step before removing data from the selected drive forever. Type 
ERASE-ALL-DATA in the text box and press ENTER or click OK. 

8. The process will start and the Progress bar will appear. 
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9. To stop the process at any time, press ESC. You can also end the process by 
clicking on Stop All button or by clicking on the red square at the Load System 
devices panel near the progress bar of the drive that was being erased. 

 

After the Wipe or Kill operation is complete, information about the wipe or erase session 
is displayed in the Session Log: 

 

 

 

Erase/Wipe Options 

 

 

Verification: In order to verify the wipe method, you will need to select the Verification 
check box and set the amount of area that the utility will read in order to verify the wipe 
method. Because verification is a long process, you can specify a percentage of the 
surface to be verified. To wipe or erase without verification, clear this check box.  

Wipe out Deleted/Unused data: This parameter appears only when you are wiping 
data from unused space on the hard drive. The wiping process clears data residue from 
unoccupied space on the hard drive and does not affect installed applications or existing 
data. This process contains three options: 

 Wipe unused clusters 

 Wipe Metadata/System file area 
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 Wipe slack space in file clusters 

You can choose to run only one or two of these options in order to make the process 
faster. If you want a thorough wiping of unused space, then include all of the options. 

 

General Options 

 

General parameters allow you to turn features on or off or change default settings 
before you erase or wipe data from an unoccupied space.  You can also change the 
look and feel of the application and its logging options. To view and change settings, 
press the F2 key, or click the Preferences… from Tools menu. 
 
 

Initialize Disk(s) after Kill/Erase: Because of the BIOS restrictions of some 
manufacturers, a hard disk device that is larger than 300 MB must have an MBR (Master 
Boot Record) in sector zero. If you erase sector zero and fill it with zeros or random 
characters, you might find that you cannot use the hard drive after erasing the data. For 
this reason KillDisk is programmed to create an empty partition table and write a typical 
MBR in sector zero. This process is otherwise known as disk initialization. 

Write Fingerprint to the first sector: If fingerprint has been written to the disk’s first 
sector, next time you boot from this disk, you will see a disk erase status, like this:  

 

If by any chance the errors have occurred or the erasing has been stopped, status will 
be FAILED and displayed in red color. 

Save Log & Shutdown PC after completion: Erasing can take many hours. You can 
leave the KillDisk working and set it to turn the computer off when erasing is completed. 
A log file will be saved and can be reviewed later. 

Skip Disk Erase Confirmation: The confirmation screen is the final step before 
erasing data.  In this screen, you type ERASE-ALL-DATA to confirm what is about to 
happen. If Skip Confirmation is turned on, this final safety request will not appear.  This 
option is typically used with caution by advanced users in order to speed up the process. 
It is safer to run KillDisk when Skip Disk Erase Confirmation is selected by default. You 
may want to use this as a safety measure to ensure that data from the correct drive 
location is going to be erased completely with no possibility of future data recovery. 

Ignore Disk Write Errors (bad sectors): If this option is turned on, error messages 
will not be displayed while data erasing or verification is in progress. All information 
about errors will be written to the KILLDISK.LOG file. These messages will be displayed 
in the final Erasing report after the process has been completed. 

Stop Process after Writing Errors: If by any chance writing errors appear during the 
wipe or deletion, you can adjust after how many errors would you like the KillDisk to 
terminate the process. 
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Retry Attempts: To specify the number of retries to do when an error is encountered, 
enter the number in Retry Attempts. 

Clear Log File before Start: To truncate the session log before erasing or wiping 
starts, select the Clear Log File before Start check box. To append this session’s 
information to the existing session log, clear the Clear Log File before Start check box.  

Note  For more detailed instructions and support, see the Active@ KillDisk User 
Guide. 
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3.1.8 Active@ Partition Manager 

 

Use this utility to perform maintenance tasks on hard drive partitions. 

 

To use Active@ Partition Manager: 

 From the Active@ Boot Disk shell, click Start > Programs > Active@ Partition Manager.  
You will be greeted with Active@ Partition Manager Getting Started welcoming screen 
offering you most commonly used actions for this application. Create Partition-directly 
manage the unallocated space on your hard drive. Partition Manager- manage and 
edit your existing partitions 
 

 To enter the Partition Manager View  click on Partition Manager 
 

 To view the properties of the selected device, right click on it and choose Properties. 
The device properties report box appear in the right panel 

 

 To create a partition: 
a. On a hard disk device, click an Unallocated area in the list to select it. 

 

b. Click Create, which will initialize Create Partition dialog box. 
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c. In Partition geometry, type the partition offset (in sectors) and the 
partition size (in megabytes).  

d. The maximum available size for the partition is set by default.  

e. In Partition Attributes, select a drive letter from the drop-down list. 

f. To format this partition, select the Format New Partition check box  
and set parameters for the format action. 

g. Click Create. The partition is created. 

 
 To delete a partition: 

a. Right click on a partition that you want to delete. 

b. Click Delete. A message will appear asking for your confirmation. 

c. Click Yes. The partition is deleted. 

  

 To format a partition: 
a. Right click on a partition in the list to select it and open the Partition 

Manager Menu. 

b. By choosing Format, you will launch the Format Partition window box. 

 

c. Give the partition a volume label in Volume Label. 
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d. Select a file system type in the File System drop-down list. 

e. Select an allocation unit size in the Allocation unit size drop-down list. 

f. To perform a quick format, select the Perform a quick format check 
box. 

g. To perform a full format, clear the Perform a quick format check box. 

h. Click OK, the process will be initialized and the progress bar will appear. 

  

 To change the letter for a device or volume: 
a. Select a device or a volume and right click on it.  

b. Click Change Attributes. The Partition Attributes dialog box appears 
with the first available letter selected.  

 

c. To change the drive letter, select a letter from the Assign the following 
drive letter drop-down list. 

d. Click OK. The letter is assigned. 

Note  For more detailed instructions and support, see the Active@ Partition 
Manager User Guide. 
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3.1.9 Active@ Disk Monitor 

Monitor the reliability status of your local hard drives to help prevent data loss due to 
hard drive failure. Use this utility to perform maintenance tasks on hard drives in the 
system. 

 Note  This is the free version of this utility and some functions are disabled. 
Some functions that are enabled apply only when using the stand-alone 
version of Active @ Hard Disk Monitor. 

To use Active@ Hard Disk Monitor: 

1. From the Active@ Boot Disk shell, click Start > Programs > Active@ Hard Disk 
Monitor. The Active@ Hard Disk Monitor workspace appears. 

 

 2. To change the settings of the utility, click Preferences.  

e. When the Preferences dialog box appears, do the following: 

a. In the Poll settings tab: 
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b. To change the frequency for checking status of the device, make changes 
in the Check every fields. 

c. To change the frequency for checking the amount of free disk space, 
make changes in the Check Free Disk Space every fields. 

d. To show which disk to monitor, choose it from the Disk drop-down list. 

e. In the Environment tab: 

 

f. To change how drive temperature is displayed, choose a different setting 
in the Show temperature in drop-down list. 

g. To change the appearance of the workspace, choose a different setting in 
the Style drop-down list. 

2. From the Local System Disks list, click a device to select it. Information about 
the selected device will be shown in the right panel. 

3. To display attributes about the device, click the Basic Info tab. Attributes appear 
in the panel. 
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4. To display SMART attributes, click the SMART Info tab. Performance and health 
attributes appear in the panel. 

 

5. To scan the selected device for bad blocks, click the Scan Disk tab and do the 
following: 
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 To change the block size, in the Check Block Size area, choose one of 
the three options. 

 To specify a start sector and a stop sector for the scan, type the sector 
numbers in the From sector and To sector fields. 

 Click Start Scan. The process will start indicating the progress in the bar. 

 To stop the scan at any time, click Stop Scan. 

 After the scan is complete, the Scan Disk Complete message box will 
appear with the scan details. 

 To view a list of events run in the session, click Event Log. A list of 
events appears in the panel. 

Note  For more detailed instructions and support, see the Active@ Disk Monitor 
User Guide. 
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3.2 Network 

This section describes the following: 

Map Network Drive - A Mapped Drive is typically a place on a network’s server hard 
drive that has been created or designated as a shared folder and assigned a local drive 
letter.  The drive has been awarded with specific permissions of use as the folder will 
store information for particular users or groups. 

 

Network Configurator - In computer networking, the ARP (Address Resolution 
Protocol) is the method for finding the host's hardware address when only its network 
layer address is known. Use the Network Configurator utility to configure TCP/IP and 
Windows firewall settings. 

 

Remote Desktop Connection – Being the integral part of Microsoft Terminal Services, 
you can use this utility to allow a remote user to take control of your computer (Remote 
Desktop Client). Microsoft provides the client software Remote Desktop Connection for 
most Windows operating systems that allows users to connect and work with a remote 
server running Terminal Services. 
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3.2.1 Map Network Drive 

To map a network drive: 

1. From the Active@ Boot Disk shell, click Start > Network > Map Network 
Drive. The Map Network Drive dialog box appears.  

2. In Drive, select a drive letter to be assigned. 

 

3. In Folder, type the server and share the name of computer or folder you want. 
For example: \\servername\sharename.  

4. To search for the computer or folder, click Browse button […].  

5. If it is necessary to change the user name in order to map the selected drive, do 
the following: 

a. Enter the domain name and the user name that has a permission to 
connect to the selected computer or folder.  

b. Enter the password for the user named above.  

6. Click Connect 

 

Note  Mapped drives are available only when the host computer is available. 
Network drives are assigned letters from Z to A, and local drives (your 
hard drive and removable storage devices) are assigned letters from A to 
Z. You can assign a computer or shared folder to a different drive letter 
by disconnecting from the drive and then reassigning it to a new drive 
letter.   
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3.2.3 Network Configurator 

This utility works only on computers with adapters that are configured to obtain an IP 
address automatically. It renews DHCP configuration for all adapters. 

To configure the IP address: 

1. From the Active@ Boot Disk shell, click Start > Network > Network 
Configurator.  

2. The Network Configurator dialog box appears. 

 

3. If network service has not been started at boot up time, start it by clicking toolbar 
button Initialize Network. 

4. From the Ethernet Adapters drop-down list, select an adaptor.  

5. To view details about the selected adaptor, hover the mouse over the Ethernet 
Adapters field. A drop-down text screen will appear. 

6. In the IP tab, do the following: 

 To get an IP address automatically from the network server, select the Obtain 
an IP address automatically radio button. 

 To use a specific IP address, select the Use the following IP address radio 
button and type the information in the fields below. 

7. In the DNS tab, do the following: 

 To get a DNS automatically from the network server, select the Obtain DNS 
Server address automatically radio button. 

 To use a specific DNS address, select the Use the following DNS Server 
address radio button and type the information in the fields below. 

8. In the Network Identification tab, to specify a workgroup for group access, type 
the workgroup name in the Workgroup field and click Set. 

9. In the Firewall tab, you can set the status of the firewall in the Firewall status 
drop-down list: 
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 To turn the firewall on, choose On. 

 To turn the firewall off, choose Off. 
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3.2.3 Remote Desktop Connection 

To use this utility, Remote Access Service must be installed and running on the 
server you want to connect to.  

 

Use the Active@ Boot Disk View Network Status utility to ensure that your client 
computer has an active network connection.  

To connect to another computer using Remote Desktop Connection: 

1. From the Active@ Boot Disk shell, click Start > Network > Remote Desktop 
Connection. The Remote Desktop Connection dialog box will appear: 

 

2. In the Computer field, type the URL for the home directory of the Web server 
hosting Remote Desktop Web Connection.  

3. To set more parameters for the connection, click Options >> and specify 
information for your connection.  

4. Click Connect. 
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3.3 Utilities 

Use these utilities to perform different support tasks. 

 

Explore My Computer – Use Boot Disk Explorer to access the file system. Browse, 
copy, move and delete files and folders. Burn data to CD/DVD discs. 

 

7-Zip File Manager – powerful file manager, supports access to nearly all file archives. 
Packing and unpacking: 7z, XZ, BZIP2, GZIP, TAR, ZIP and WIM. Unpacking only: ARJ, 
CAB, CHM, CPIO, CramFS, DEB, DMG, FAT, HFS, ISO, LZH, LZMA, MBR, MSI, NSIS, 
NTFS, RAR, RPM, SquashFS, UDF, VHD, WIM, XAR and Z file formats. 

 

Notepad Text Editor – When you are performing maintenance on a hard disk or if you 
are repairing or recovering lost or damaged data on a disk, you might want to record 
technical information about the disk before making changes. This information can prove 
to be helpful if you need to remember the original configuration when restoring data 
after a system crash or when contacting technical support.   

 

Calculator – A calculation application included with Microsoft Windows. 

 

Honeyview Image Viewer - is a very fast image viewer supporting various picture 
formats (BMP, JPG, GIF, PNG, PSD, DDS, JXR, WebP, J2K, JP2, TGA, TIFF, PCX, PNM, 
PPM, BPG), including camera raw images (DNG, CR2, CRW, NEF, NRW, ORF, RW2, PEF, 
SR2, RAF). 

 

SumatraPDF Document Viewer - is a fast, minimalistic PDF, XPS, DjVu, CHM, CBZ 
and CBR document reader with no external dependencies. 

 

Registry Editor – View and edit registry information in the current operating system. 
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3.3.1 Explore My Computer 

Boot Disk Explorer is a fast, small, compact and innovative file manager, similar to 
Windows Explorer.  

 

 

 

Boot Disk Explorer has some additional features that can’t be found in Windows 
Explorer: 

 Displays the total size of each folder. 

 Allows you to browse folders from a tree-view \ list-view interface.  

 You can map an FTP server as a drive letter, the same way that you would map a 
network drive using buttons on the toolbar. 

 When you copy a file, the progress bar will provide you with the information about 
the ongoing process. 

 Using ZDelete toolbar button, you can permanently destroy selected files and 
folders permanently. 

 Using Burn Disk toolbar button, you can burn data files and folders from CD/DVD 
Burner basket 
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3.3.2 7-Zip File Manager 

7-Zip is a file archiver with a highest compression ratio. Usually, 7-Zip compresses to 7z 
format 30-70% better than to zip format.  

7-Zip File Manager – two panel file manager, being able to browse, preview, copy, 
move, rename and delete files and folders, as well as create and de-compress file 
archives of different formats. 

It is an open source software, most of the source code is under the GNU LGPL license. 

 

 

Main features: 

 High compression ratio in 7z format with LZMA and LZMA2 compression 

 Supported formats: 

o Packing / unpacking: 7z, XZ, BZIP2, GZIP, TAR, ZIP and WIM 

o Unpacking only: ARJ, CAB, CHM, CPIO, CramFS, DEB, DMG, FAT, HFS, 
ISO, LZH, LZMA, MBR, MSI, NSIS, NTFS, RAR, RPM, SquashFS, UDF, 
VHD, WIM, XAR and Z. 

 For ZIP and GZIP formats, 7-Zip provides a compression ratio that is 2-10 % 
better than the ratio provided by PKZip and WinZip 

 Strong AES-256 encryption in 7z and ZIP formats 

 Self-extracting capability for 7z format 

 Integration with Windows Shell 

 Powerful File Manager 

 Powerful command line version 
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3.3.3 Notepad Text Editor 

Notepad is a simple text editor for Microsoft Windows and a basic text-editing program 
that you can use to create documents. 

 

 

 

Notepad is a common text-only (plain text) editor. The resulting files—typically saved 
with the .txt extension—have no format tags or styles, making the program suitable for 
editing system files to use in a DOS environment and, occasionally, source code for later 
compilation or execution, usually through a command prompt. It is also useful for its 
negligible use of system resources; making for quick load time and processing time, 
especially on under-powered hardware. Notepad supports both left-to-right and right-to-
left based languages. Notepad does not treat newlines in Unix- or Mac-style text files 
correctly. Notepad offers only the most basic text manipulation functions, such as 
finding and replacing text. 
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3.3.4 Calculator 

Calculator is a software calculator included in all versions of Windows. 

 

 

 

When Calculator runs in standard mode, it resembles a four-function calculator. More 
advanced functions are available in scientific mode, including logarithms, numerical base 
conversions, some logical operators, operator precedence, radian, degree and radians 
support as well as simple single-variable statistical functions. Separate programmer, 
statistics, unit conversion, date calculation and worksheets modes were also added to 
help different types of users solving specific tasks. 
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3.3.5 Honeyview Image Viewer 

Honeyview Image Viewer provides ultrafast rendering with optimized image processing. 

 

 

 

Features: 

 Support for Various Image Formats - BMP, JPG, GIF/Animation GIF, TIFF, PNG, 
TGA, PSD, JPEG 2000(JP2, J2K), JPEG XR/HD Photo (JXR, WDP, HDP), Adobe 
Digital Negative(DNG), DDS, WebP, and PCX formats are supported. 

 Direct View for Compressed Files - Images can be viewed without extracting (but 
with memory decompressing) compressed files (ZIP/CBZ, RAR/CBR, ALZ, EGG, 
LZH, TAR, 7Z, HV3, CAB, and ISO).  

 EXIF View - Click the "EXIF" button in the upper-left corner to display EXIF 
information along with the file information.  

 GPS View - Many smartphone photos (taken by iPhone or Galaxys) include GPS 
information. It displays GPS information of a photo on Google Maps.  

 Slideshow View - Click the [Slideshow] button on the top of the window to start a 
slideshow with the currently displayed pictures at a certain interval (1–90 sec).  

 Add/Edit Bookmarks - Click the [Bookmark] button on the top of the window to 
go to frequently viewed images.  

 Copy/Move to Photo folder - Click the [Photo folder] button in the upper-right 
corner to copy/move the currently displayed photo to [Photo folder 1] or [Photo 
folder 2].  

 Support for Keyboard Shortcuts - Honeyview supports many keyboard shortcuts 
for user convenience.  
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 Support for Sound & Shot Files - Honeyview supports Sound & Shot files and the 
audio file to which image and sound is simultaneously recorded. 

 Fast Image Processing - Optimized image processing provides faster image 
loading and filtering than competitors 

 Support for Unicode - Unicode is supported to fully display Chinese, Russian, 
Japanese, etc., in foreign-language Windows. 

 Auto Image Rotation - With EXIF information, Honeyview automatically rotates a 
picture to the correct position. 

 Support for 64-bit OSes - Honeyview fully supports 64-bit OSes for faster 
processing. 
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3.3.6 SumatraPDF Document Viewer 

SumatraPDF is an open source PDF reader for Microsoft Windows. The program also 
opens Open XML Paper Specification, DjVu, EPUB, XPS, FB2, CHM, CB7 CBR CBT CBZ, 
MOBI and PRC files. 

 

 

 

Sumatra has a minimalistic design, with its simplicity attained at the expense of 
extensive features. For rendering PDFs it uses the MuPDF library. Sumatra was designed 
for portable use, as it consists of one single file with no external dependencies, making it 
usable from an external USB drive. 

When re-opening a document, the rotation, zoom, window size, page, etc. are 
remembered from the last time that document was opened, making it behave more like 
an e-book reader than some other PDF viewers.  

Sumatra does not lock the PDF file. Without closing the PDF file, a user can save over 
the PDF and then press the R key to refresh the PDF document. For example, a user 
could find this feature useful when, after recompiling the altered TeX source code, 
simply pressing 'R' and view the altered document. 
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3.3.7 Registry Editor 

You can review and change local registry parameters after loading a registry hive from 
any partition that is detected by Active@ Boot Disk utilities. If your computer cannot 
complete a boot-up and if the boot failure is related to registry parameters of a driver or 
another bootable configuration, you may still be able to fix it by changing registry 
parameters using Registry Editor. 

 

To use Registry Editor: 

1. In order to launch Registry Editor from the Active@ Boot Disk shell, click on 
Start > Utilities > Registry Editor.  

2. In the registry hierarchy list, choose either HKEY_LOCAL_MACHINE or 
HKEY_USERS hive.  

3. From the File menu, choose Load Hive…  

4. The Load Hive dialog box appears. 

5. Browse to the primary logical drive (for example, C:) and navigate to 
Windows\System32\config where you will find the contents of the config 
folder. 

6. Choose a registry hive. For example choose one of: 

 SYSTEM 

 COMPONENTS 

 SOFTWARE 

7. Click Open, which will open the Load Hive dialog box. 

8. In Key Name, type a custom name for the hive that you are loading. For 
example MY_SOFTWARE_HIVE. 

 

9. Click OK. The new hive will appear in the registry hierarchy under the root level 
that you have previously selected in step 2. 

10. Open the loaded hive in order to view and edit registry values, create and delete 
new entries or keys. 

11. After you have completed all the changes in the loaded hive, close the Registry 
Editor. All changes are written to the registry hive that was previously attached. 

12. Exit Active@ Boot Disk and restart the computer. 
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3.4 System 

Many of these utilities are familiar Windows functions. With Active@ Boot Disk, you can 
access them even if your hard drive is damaged. 

 

System Information – Displays system information about your local machine. 

 

Check Local Disks – An applet that helps you create and display a status report for 
your hard drive. 

 

Display Settings – Choose the resolution and number of colors displayed. 

 

Task Manager – Get information about computer performance and details about 
running applications, processes, network activity, user and system services. View or 
modify currently running services. View the full name of a process. Monitor applications 
and services running system performance and resources. 

 

Set Date, Time & Zone – Change your computer’s date, time and time zone. 

 

Local Registry Search Utility – Search for and display specified registry details or 
create a custom registry hive. After you find the registry hive that you are looking for, 
you can edit it with Registry Editor. 

 

Add Language & Keyboard – Add language support for a second language. This 
includes special keyboard layout and the ability to display language characters on the 
screen. You can use a different language for a file name or when recording notes about 
changes made to the system. 

 

Bootable Configuration Editor – View and edit entries in BCD (Boot Configuration 
Data) store to make a Windows system partition bootable 
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3.4.1 System Information 

This utility displays in-depth details about your local system.  

 

To open System Information: 

1. In the Active@ Boot Disk shell, click Start > System > System Information. 
The SysInfo display box appears.  

 

After the SysInfo screen appears, system information details appear in six categories: 

 System Summary – Operating system, BIOS, Processor, RAM and more. 

 Installed Devices – All classes of devices, including batteries, drives, human 
interface devices, controllers, etc.  

 Environment Variables – Processor architecture, revision number, as well as paths 
to various tools and operating system utilities.  

 Display – Current and available display resolutions. 

 Drives – Information about local fixed disks, including amount of free space. 

 Network – IP configuration and specifications for LAN adaptor. 

To save all system information to an HTML file: 

1. Click Save SysInfo to file. The Save dialog box appears. 

2. Navigate to the folder where you want to save the information. 

3. Name the file in File name and click Save. 



 

90  Active@ Boot Disk User Guide 

3.4.2 Check Local Disks 

Check Local Disks is an applet that will help you create and display a status report for 
your hard drive. The applet also lists and corrects error on the disk.  

Similar to Windows CHKDSK, Check Disk has a list of parameters that help you perform 
various functions on your hard drive. 

 

To use Check Disk: 

1. In the Active@ Boot Disk shell, click Start > System > Check Disk. 

 The Check Disk Applet workspace will appear with a list of all hard drives in 
the Local Disks list. 

 

2. To select a hard drive, select the check box next to the drive’s name. 

3. You can add parameters to the command: 

 /F – If an error is encountered, Check Disk will fix the issue that causes the 
error. 

 /V – On a FAT or FAT32 file system, the full path and name of every file is 
displayed. On NTFS file system, only cleanup messages are displayed. 

 /R – Locates bad sectors and recovers readable information. 

 /I [NTFS only] – Performs a less vigorous check of indexes. 

 /C [NTFS only] – Skips checking of cycles within the folder structure. 

 On a FAT or FAT32 file system, you may specify an individual file to check. To 
do this, click Browse and choose the file from the Select File dialog box. 

4. After you have selected a drive and parameters, click Add all marked disks. The 
chkdsk.exe command appears in the Command list along with the drive letter 
and all parameters. 

5. To add another drive, repeat steps 2 to 4. 



 

  91 

6. To remove a drive from the Command list, select it and click Delete command 
> Delete Current. 

7. To remove all drives from the Command list, click Delete command > Delete 
All. 

8. To run all commands in the Command list, click Execute. A console session 
appears. 

9. Watch as the functions proceed. 

After the command is complete, the console session closes. 
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3.4.3 Display Settings 

Helps to choose the resolution and number of colors displayed for the current display. 

 

To use Display Settings configurator: 

1. In the Active@ Boot Disk shell, click Start > System > Display Configurator. 
The List All Modes list appears with a list of all valid modes.  

 

2. Click a mode to select it. The Apply button is enabled. 

3. Click Apply. The Monitor Settings will appear. 

 

The display mode is changed. 
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3.4.5 Task Manager 

Use Task Manager to troubleshoot issues, start programs, end processes, and to monitor 
computer's performance. 

 

 

 

To open Task Manager, click Start > System > Task Manager. You may also use the 
familiar key combination – Ctrl+Alt+Del to open Task Manager. 

The Applications tab displays the status of the programs that are running on the 
computer. 

The Processes tab displays information about the processes that are running on the 
computer. A process can be an application that you start or subsystems and services 
that are managed by the operating system. 

Similarly, the Services tab displays information about the services that are running on 
the computer. 

Click the Performance tab to view a dynamic overview of the performance of your 
computer, you can monitor, for example memory available for the current tasks. 
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3.4.6 Set Date, Time & Zone 

When you set display configuration options for date and time in the operating system, 
these settings affect the Date dialog box and other operating system windows. The Date 
& Time changer also adopts the settings as you enter dates and times. 

To open the Date & Time changer, click Start > System > Date, Time & Zone. 

If you create records that are date and time dependent, they are stored in the current 
time zone. If you change the time zone setting, records in the database are not changed 
to reflect the new time zone setting. You must go back and manually change each 
record to agree with the new time zone setting. 

 

To set the date and time: 

1. Click the Date & Time tab. 

2. Use the calendar to pick the current date. 

3. In the digital time box, click the hour, minute or second. 

4. Use the spinner control to change the digit forward or backward. 

5. Click Apply. 

 

To set the time zone: 

1. Click the Time Zone tab. 

 

2. From the drop-down list, set your time zone, relative to GMT (Greenwich Mean 
Time). 

3. Click Apply. 
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3.3.7 Search & Edit Local Registry Utility 

This utility searches for registry hives in the local drives, and attaches them to the 
Registry Editor for viewing or editing. 

To describe what this utility can help you do, this section will describe the steps required 
to recover from the Windows registry hive corruption in a case where the file table is still 
intact. 

To recognize the situations when you have a Windows registry hive corruption, while 
trying to start Windows 2000 or Windows XP, you might get a message similar to this: 

  Windows could not start because the following file is missing or corrupt: 
\WINDOWS\SYSTEM32\CONFIG\SYSTEM 

or 

  \WINDOWS\SYSTEM32\CONFIG\SOFTWARE 

When you boot with Active@ Boot Disk, Windows PE will mount the un-functional drive 
and assign it a different drive letter in order for you to have exclusive access to it.  

To repair the broken registry hive, do the following: 

1. From the Active@ Boot Disk shell, click Start > Utilities > Search & Edit Local 
Registry.  

2. The Attach and Edit Local Registry dialog box appears. 

 

3. To search local drives, do the following: 

 Click the Perform search for Registry sets located on local disks radio 
button. 

 Choose the local drive folder that was mentioned in the error message. 

 Click Search. Drive and folder names will appear below the search button as 
they are being searched. 

 Results of the search appear in the Results list. 
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 Select the broken hive in the Results list. The Attach as box is enabled. 

 Continue with step 4 below. 

4. To browse directly to the broken hive, do the following: 

 Click the Direct location radio button. Controls in the lower area are 
enabled. 

 Click the ellipsis button (…) and browse to the broken hive. 

5. In the Attach as box, type a custom hive name. This is a temporary name, so the 
actual name does not matter. 

6. Click Attach & Edit Registry Hive. The Registry Editor appears with the 
custom hive selected.  

 
If you are repairing a broken hive, Registry Editor will display a message that 
says “One or more files containing the registry were corrupt and had to be 
recovered by use of log files. The recovery was successful.”  

7. In Registry Editor, select the temporary hive that you just created. From the File 
menu, choose Unload Hive. 

8. Dialogue box asking for your confirmation will appear. Click Yes. The temporary 
hive is unloaded. 
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3.3.8 Add Language & Keyboard Layout 

The default language for Active@ Boot Disk is English. You can add an alternate 
language keyboard functional layout in order to give a file a descriptive name or when 
recording notes about changes made to the system.  

A typical English keyboard layout (called QWERTY) may be suitable for many Latin-
based languages. With the French keyboard layout (AZERTY) the key associations 
produce a different result on the screen. 

You must be familiar with the different key associations to use a different language 
keyboard layout. 

To add a keyboard layout: 

 From the Active@ Boot Disk shell, click Start > Utilities > Add Keyboard Layout. 
The Add Keyboard Layout dialog box appears. 

 

 Choose the radio button for the alternate keyboard layout that you want to use. 

 Click Set. A short form for the current keyboard layout will appear in the system tray 
area. 

The alternate keyboard layout has been set. 

To toggle between the default keyboard layout and the alternate keyboard layout, press 
Left ALT+SHIFT on the keyboard. 
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3.3.9 Bootable Configuration (BCD) Editor 

Active@ BCD Editor is a Windows-based utility that allows you to edit entries in BCD 
(Boot Configuration Data) store to make a Windows system partition bootable 

Boot Configuration Data (BCD) is a database for boot-time configuration data. It is used 
by Microsoft's Windows Boot Manager and replaces the boot.ini that was used by 
NTLDR. It carries a set of entries describing booting options and location of Windows 
Boot Loader, Windows Resume application and other important programs. BCD was 
introduced along with Windows Vista and it is a replacement of older boot.ini format. 
BCD store is used by Windows Vista, Windows 7, Windows 8, Windows Server 2008, 
Windows Server 2012 and Windows 10. 
 

 
 
After the launch Active@ BCD Editor scans all disks in the system and looks for BCD 
stores which could be more than one if there are disks presented containing boot 
configuration from another machine. The first BCD store is open and available to edit. 
Before making changes make sure that you use a correct BCD store. Use Open BCD 

command to change the current BCD store. The main screen contains a list of all BCD 
store entries and their parameters. Out of those parameters only Application device 
and OS device are intended to be changed, all other data is shown for information 
only. The main task of BCD Editor is to assign a correct device for each application in 
BCD store, so Windows would be booted correctly. 
 
For more information, read Active@ BCD Editor documentation.  
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3.5 Internet 

 

The Active@ Boot Disk Internet utilities include: 

 Internet Browser – Fast, customizable, portable and lightweight web browser 
for the Windows platform.  

 Mail Sender – Send an email message with attachments quickly and easily. 



 

100  Active@ Boot Disk User Guide 

3.5.1 Internet Browser 

You may access information from the Internet quickly and easily using Portable Internet 
Browser. 

 

 

 

Here are some features in Internet Browser: 

 When you start a new browser session, you may choose to restore the settings 
and tabs from the last session. This option is useful if you accidentally closed the 
browser. 

 Turn on Private Browsing mode and you will not leave any traces of your activities 
on your computer. When you visit a web page, a text string is sent to identify 
such things as the application name, version, host operating system, and 
language. With Private Browsing, even this text string is masked.  

 Supports SSL (Secure Sockets Layer) for secure communications on Internet web 
sites. 
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3.5.2 Mail Sender 

Use a simple Mail Sender to send an email message to ask for support or to make any 
other kind of contact. 

To use Mail Sender: 

1. From the Active@ Boot Disk shell, click Start > Internet > Mail Sender. The 
MailSender dialog box will appear. 

 

2. In From, type the email address that the recipient can reply to. 

3. In To, type the destination email address where you want the message sent. 

4. In Subject, type the subject of the email.  

5. To add an attachment, click the Attachment button and navigate to the file that 
you want to attach.  

6. To use your existing email service provider, in Settings, do the following: 

 In Server Name, type the outgoing mail server (SMTP) address in the 
format “servername.hostname.extension”. This is the mail server that 
will accept the email message from the application and forward it to 
the destination email address. 

 In Port, select a port number using the scroll field. (Usually 25.) 

 If your email server requires authentication, select the 
Authentication check box and provide the user name and password. 

7. Click Send. 

 

Note:  You cannot receive emails with this simple Mail Sender client. 
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3.6 Console Tools 

 

The Active@ Boot Disk console utilities include: 

 

 Command Prompt – Run command prompt utility (cmd.exe) to create and run 
batch files or perform other DOS commands. 

 View Network Status - ipconfig (IP Configuration) in Windows is a utility to 
print the local computer's current network configuration. 

 Partition Manager (DiskPart.exe) – Command line tool to create, delete, 
format and resize basic partitions and logical partitions, and manage dynamic 
volumes. 

 RAID Manager (DiskRAID.exe) – Command line tool to create, delete, format 
and resize basic partitions and logical partitions, and manage dynamic RAIDs. 

 FTP Client – A console utility to help you download or upload files from an FTP 
site. 
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3.6.1 Command Prompt 

To open the DOS-like command line interpreter, click Start > System > Command 
Prompt (Cmd.exe). 

 

 

 

In this environment, you may run character-based applications and utilities. You can use 
command prompt to create and edit batch files to automate routine tasks. This can 
make you more efficient than if you were doing these tasks using Boot Disk Explorer. 

For more information about command line console commands, see 
http://technet.microsoft.com/en-ca/library/bb491071.aspx. 

http://technet.microsoft.com/en-ca/library/bb491071.aspx
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3.6.2 View Network Status 

This utility works only on computers with network adapters.  

The ipconfig utility displays current TCP/IP network configuration values, updates, or 
releases, DHCP (Dynamic Host Configuration Protocol) allocated leases, and display, 
register, or flush DNS (Domain Name System) names. 

 

 

 

To view the status of the local area connection: 

1. From the Active@ Boot Disk shell, click Start > Network > View Network 
Status.  

2. The View Network Status console session appears showing Windows IP 
Configuration. 

3. To close the console session, press any key on the keyboard.  
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3.6.3 DiskPart Partition Manager 

DiskPart is a text-mode command interpreter. This tool enables you to manage objects 
(disks, partitions, or volumes) by using scripts or direct input at a command prompt. 

 

 

 

Diskpart enables a superset of the actions that are supported by the Disk Management 
Control Panel snap-in. The Disk Management snap-in prohibits you from inadvertently 
performing actions that may result in data loss. It is recommended that you use the 
Diskpart utility cautiously because Diskpart enables explicit control of partitions and 
volumes. 

You can use Diskpart to convert a basic disk to a dynamic disk and backward. The basic 
disk can either be empty or contain either primary partitions or logical drives. The basic 
disk can be a data disk or system or boot drive.  

You can use Diskpart to create a partition at an explicit disk offset. The Disk 
Management snap-in places the partition at the end of any occupied area or on the first 
sufficiently large area. On master boot record (MBR) disks, the partition offset and the 
size are rounded to preserve the required cylinder alignment. Offsets are rounded to the 
closest valid value, and the size is always rounded up to the next valid value. Diskpart 
does not assign a drive letter to a newly created partition. Use the assign command to 
assign either a mount point or a drive letter. 

Diskpart permits certain partition deletion operations that are blocked by the snap-in. 
For example, you can use Diskpart to delete MBR OEM partitions. However, these 
partitions often contain files that are important to the platform operation. Diskpart 
blocks the deletion of the current system, boot, or paging volumes and partitions. Also, 
Diskpart blocks deletion of the partitions that underlie dynamic disks. 

Diskpart causes disk signatures, GUID partition table (GPT) disk globally unique 
identifiers (GUIDs), and GPT partition GUIDs to be generated.  

The Diskpart utility includes support for the new disk partition scheme called GPT. You 
cannot use GPT disks on any x86-based Windows XP-based or Windows 2000-based 
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computers. Diskpart enables the conversion of GPT partitioning to MBR partitioning only 
for empty disks. 

You can use Diskpart to delete missing dynamic disks. Dynamic disks contain a shared 
database; all of the dynamic disks on a computer have knowledge of all other dynamic 
disks on that computer. When dynamic disks are moved, the original computer considers 
these disks as "missing".  

Drive letters are not automatically assigned when you use Diskpart. To ensure that a 
given partition or volume has a drive letter, you must explicitly assign a drive letter. You 
can either assign the drive letter or allow the next available drive letter to be allocated. 

 
DiskPart Commands 
Before you can use DiskPart commands on a disk, partition, or volume, you must first 
list and then select an object to give it focus. When an object has focus, any DiskPart 
command that you input will affect that particular object. 

You can list the available objects and determine an object's number or drive letter by 
using the list disk, list volume, and list partition commands. The list disk and list volume 
commands display all disks and volumes in the computer. However, the list partition 
command displays only partitions on the disk that have focus. When you use the list 
commands, an asterisk (*) appears next to the object with focus. You select an object 
by its number or drive letter, such as disk 0, partition 1, volume 3, or volume C. 

When you select an object, the focus remains on that object until you select a different 
object. For example, if the focus is set on disk 0, and you select volume 8 as on disk 2, 
the focus shifts from disk 0 to disk 2, volume 8. Some commands automatically change 
the focus. For example, when you create a new partition, the focus automatically 
changes to the new partition. 

You can give focus only to a partition on the selected disk. When a partition has focus, 
the related volume (if any) will also have focus. When a volume has focus, the related 
disk and partition also have focus if the volume maps to a single specific partition. If this 
is not the case, then focus on the disk and partition is lost. 

Run: 

> DiskPart.exe ? 

To see all DiskPart commands and syntax. 

 
DiskPart Scripting 
By using the DiskPart Command-Line Options command-line tool, you can create scripts 
to automate disk-related tasks, such as creating volumes or converting disks to dynamic 
disks. Scripting these tasks is useful if you deploy Windows by using unattended Setup 
or the Sysprep tool, which do not support creating volumes other than the boot volume. 

To start a DiskPart script, at the command prompt, type: 

> DiskPart.exe /s scriptname.txt  

…where scriptname is the name of the text file that contains your script. 

Read more detailed information on DiskPart usage:  

https://technet.microsoft.com/en-us/library/cc766465(v=ws.10).aspx  

https://technet.microsoft.com/en-us/library/cc766465(v=ws.10).aspx
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3.6.4 DiskRAID Manager 

DiskRAID is a command-line tool that enables you to configure and manage redundant 
array of independent (or inexpensive) disks (RAID) storage subsystems. 

RAID is a method used to standardize and categorize fault-tolerant disk systems. RAID 
levels provide various mixes of performance, reliability, and cost. RAID is usually used 
on servers. Some servers provide three of the RAID levels: Level 0 (striping), Level 1 
(mirroring), and Level 5 (striping with parity). 

A hardware RAID subsystem distinguishes physically addressable storage units from one 
another by using a Logical Unit Number (LUN). A LUN object must have at least one 
plex, and can have any number of additional plexes. Each plex contains a copy of the 
data on the LUN object. Plexes can be added to and removed from a LUN object. 

Most DiskRAID commands operate on a specific host bus adapter (HBA) port, initiator 
adapter, initiator portal, provider, subsystem, controller, port, drive, LUN, target portal, 
target, or target portal group. You use the SELECT command to select an object. The 
selected object is said to have focus. Focus simplifies common configuration tasks, such 
as creating multiple LUNs within the same subsystem. 

 

Example: 

To select subsystem 0, type the following at the DiskRAID prompt: 

 DISKRAID> select subsystem 0 

Press ENTER. Output similar to the following is displayed: 

 Subsystem 0 is now the selected subsystem. 

 

To list all drives in the system, type: 
 

DISKRAID> list drives 

 

  Drive ###  Status      Health          Size      Free    Bus  Slot  Flags 

  ---------  ----------  ------------  --------  --------  ---  ----  ----- 

  Drive 0    Online      Healthy         107 GB    107 GB    0     1 

  Drive 1    Offline     Healthy          29 GB     29 GB    1     0 

  Drive 2    Online      Healthy         107 GB    107 GB    0     2 

  Drive 3    Not Ready   Healthy          19 GB     19 GB    1     1 

 

Read more detailed information on DiskRAID usage:  

https://technet.microsoft.com/en-us/library/cc770763.aspx 

  

https://technet.microsoft.com/en-us/library/cc770763.aspx
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3.6.5 FTP Client 

Use Microsoft FTP Client (console) to transfer files to and from your computer running 
an FTP (File Transfer Protocol) server service such as Internet Information Services. FTP 
can be used interactively or in batch mode by processing ASCII text files. 

 

 To launch FTP Client from the Active@ Boot Disk shell, click Start > Internet 
> FTP Client. 

 

Type: 

 > ftp /? 

To see the list of commands available and the syntax. 

 

Examples:  

 

To anonymously log on to the FTP server named ftp.example.microsoft.com, type the 
following command:  

ftp -A ftp.example.microsoft.com  

 

To log on to the FTP server named ftp.example.microsoft.com and run the ftp 
commands contained in a file named Resynch.txt, type the following command: 

 

ftp -s:resynch.txt ftp.example.microsoft.com  

 

Read more detailed information on FTP client usage:  

http://www.microsoft.com/resources/documentation/windows/xp/all/proddocs/en-
us/ftp.mspx?mfr=true 
 
 
  

http://www.microsoft.com/resources/documentation/windows/xp/all/proddocs/en-us/ftp.mspx?mfr=true
http://www.microsoft.com/resources/documentation/windows/xp/all/proddocs/en-us/ftp.mspx?mfr=true
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3.7 Professional Tools 

 

The Active@ Boot Disk Professional tools included in the Professional (commercial) 
package: 

 Windows PowerShell - is a task automation and configuration management 
framework from Microsoft, consisting of a command-line shell and associated 
scripting language built on the .NET Framework. PowerShell provides full access 
to COM and WMI, enabling administrators to perform administrative tasks on both 
local and remote Windows systems as well as WS-Management and CIM enabling 
management of remote Linux systems and network devices. 

 BitLocker Manager - tool can be used to turn on or turn off BitLocker, specify 
unlock mechanisms, update recovery methods, and unlock BitLocker-protected 
data drives. 

 BitLocker Repair – tool is used to recover access to BitLocker-protected drives 
that have been damaged or corrupted when access cannot be restored by using 
the recovery console. 

 iSCSI Manager - is a command-line tool for managing iSCSI device connections 
and security. 

 WMI Console - command-line interface to WMI called Windows Management 
Instrumentation Command-line (WMIC). 

 SSH Client - Secure Shell Client Library allows to connect to and control remote 
computers via secure channel using simple scripting language. 

 Telnet Client – A console utility to help you access remote sites in a terminal 
session. 
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3.7.1 Windows PowerShell 

Windows PowerShell is a task automation and configuration management framework 
from Microsoft, consisting of a command-line shell and associated scripting language 
built on the .NET Framework. PowerShell provides full access to COM and WMI, enabling 
administrators to perform administrative tasks on both local and remote Windows 
systems as well as WS-Management and CIM enabling management of remote Linux 
systems and network devices. 

 

 

 

In PowerShell, administrative tasks are generally performed by cmdlets, which are 
specialized .NET classes implementing a particular operation. Sets of cmdlets may be 
combined into scripts, executables (which are standalone applications), or by 
instantiating regular .NET classes (or WMI/COM Objects). These work by accessing data 
in different data stores, like the file system or registry, which are made available to the 
PowerShell runtime via Windows PowerShell providers. 

Windows PowerShell also provides a hosting API with which the Windows PowerShell 
runtime can be embedded inside other applications. These applications can then use 
Windows PowerShell functionality to implement certain operations, including those 
exposed via the graphical interface. Different Microsoft applications, for example 
Microsoft SQL Server 2008 also expose their management interface via PowerShell 
cmdlets. With PowerShell, graphical interface-based management applications on 
Windows are layered on top of Windows PowerShell.  

Windows PowerShell includes its own extensive, console-based help, similar to man 
pages in Unix shells, via the Get-Help cmdlet. 

 

Examples: 

 

This example lists all services registered on the machine and prints their current status: 
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Get-Service | Foreach {$_.name + " Status:-" + $_.status} 

 

This example finds all Windows Log Files with 'Error' inside: 

 

Clear-Host 
$Directory = "C:\Windows\" 
$Phrase = "Error" 
$Files = Get-Childitem $Directory -recurse -Include *.log ` 
-ErrorAction SilentlyContinue 
$Files | Select-String $Phrase -ErrorAction SilentlyContinue ` 
| Group-Object filename | Sort-Object count –descending 

 

Read more detailed information on PowerShell usage: 

http://en.wikipedia.org/wiki/Windows_PowerShell 

 

http://en.wikipedia.org/wiki/Windows_PowerShell
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3.7.2 BitLocker Manager 

BitLocker Manager - tool being used to turn on or turn off BitLocker, specify unlock 
mechanisms, update recovery methods, and unlock BitLocker-protected data drives. This 
tool can be used in place of the BitLocker Drive Encryption Control Panel item. 

BitLocker Drive Encryption (BitLocker) is a component of Windows Vista and later 
versions of Windows that helps to protect data by encrypting the entire volume and 
checking the integrity of early startup components. 

 

Examples: 

 

To unlock BitLocker-encrypted D: drive using the password: 

 

manage-bde –unlock D: -rp <recovery password>  

 

To unlock BitLocker-encrypted D: drive using the recovery key stored in the file: 

 

manage-bde –unlock D: -rk C:\<recovery-key-file name> 

 

Read more detailed information on BitLocker command-line tool usage: 

https://technet.microsoft.com/en-us/library/dd875513(v=ws.10).aspx 

 

https://technet.microsoft.com/en-us/library/dd875513(v=ws.10).aspx
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3.7.3 BitLocker Repair 

The BitLocker Repair Tool can be used to access encrypted data on a severely damaged 
hard disk if the drive was encrypted by using BitLocker. Repair-bde can reconstruct 
critical parts of the drive and salvage recoverable data as long as a valid recovery 
password or recovery key is used to decrypt the data. If the BitLocker metadata data on 
the drive has become corrupt, you must be able to supply a backup key package in 
addition to the recovery password or recovery key. With this key package and either the 
recovery password or recovery key, you can decrypt portions of a BitLocker-protected 
drive if the disk is corrupted. Each key package will work only for a drive that has the 
corresponding drive identifier.  

The Repair-bde command-line tool is intended for use when the operating system does 
not start or when you cannot start the BitLocker Recovery Console. You should use 
Repair-bde if the following conditions are true: 

1. You have encrypted the drive by using BitLocker Drive Encryption. 

2. Windows does not start, or you cannot start the BitLocker recovery 
console. 

3. You do not have a copy of the data that is contained on the encrypted 
drive. 

 

Example:  

 

To recover damaged BitLocker volume C: and store all partition’s information into the 
image file on volume D:  

 

> repair-bde C: D:\imagefile.img 

 

Read more detailed information on BitLocker repair command-line tool usage: 

https://technet.microsoft.com/en-us/library/ee706528(v=ws.10).aspx 

 

https://technet.microsoft.com/en-us/library/ee706528(v=ws.10).aspx
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3.7.4 iSCSI Manager 

iSCSI Manager (iscsicli.exe command) allows you to use the Microsoft iSCSI initiator 
without the GUI. Making it the perfect tool for scripting the iSCSI connections (Hyper-V 
Server shared storage). If you know the ip-address of your iSCSI storage and the IQN of 
the LUN you want to use (though it can be found with the command), you are all set to 
set up the connection and use your shared storage. 

 

Examples: 

 

To list all available iSCSI Targers: 

 

iscsicli.exe ListTargers  

 

To login to the particular target: 

 

iscsicli.exe QloginTarget [target-iqn] 

 

Read more detailed information on iscsicli.exe command-line tool usage: 

http://www.virtues.it/2010/04/howto-w2k8-iscsicli/ 

 

http://www.virtues.it/2010/04/howto-w2k8-iscsicli/
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3.7.5 WMI Console 

WMI Console is a command-line interface to WMI called Windows Management 
Instrumentation Command-line (WMIC). 

In Microsoft computer systems, Windows Management Instrumentation (WMI) consists 
of a set of extensions to the Windows Driver Model that provides an operating system 
interface through which instrumented components provide information and notification. 
WMI is Microsoft's implementation of the Web-Based Enterprise Management (WBEM) 
and Common Information Model (CIM) standards from the Distributed Management 
Task Force (DMTF). 

WMI allows scripting languages (such as VBScript or Windows PowerShell) to manage 
Microsoft Windows personal computers and servers, both locally and remotely.  

 

Examples: 

 

To list all processes 

 

wmic > process list 

 

To list all logical disks, their filesystem, name, size and description: 

 

wmic > logicaldisk get filesystem, name, size, description 

 

Read more detailed information on WMI & WMIC syntax: 

http://en.wikipedia.org/wiki/Windows_Management_Instrumentation 

https://technet.microsoft.com/en-us/library/cc779482(v=ws.10).aspx 

http://en.wikipedia.org/wiki/Windows_Management_Instrumentation
https://technet.microsoft.com/en-us/library/cc779482(v=ws.10).aspx
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3.7.6 SSH Client 

Secure Shell Client Library (SSH.NET) allows to connect to and control remote 
computers via secure channel using simple scripting language. 

 

 

 

Features: 

 Execution of SSH command using both synchronous and asynchronous methods  

 Return command execution exit status and other information  

 Provide SFTP functionality for both synchronous and asynchronous operations.  

 Provides SCP functionality.  

 Provide status report for upload and download sftp operations to allow accurate 
progress bar implementation  

 Remote, dynamic and local port forwarding  

 Shell/Terminal implementation.  

 Specify key file pass phrase  

 Use multiple key files to authenticate  

 Supports diffie-hellman-group-exchange-sha256, diffie-hellman-group-exchange-
sha1, diffie-hellman-group14-sha1 and diffie-hellman-group1-sha1 key exchange 
methods.  

 Supports 3des-cbc, aes128-cbc, aes192-cbc, aes256-cbc, aes128-ctr, aes192-ctr, 
aes256-ctr, blowfish-cbc, cast128-cbc, arcfour and twofish encryptions.  

 Supports hmac-md5, hmac-sha1, hmac-ripemd160, hmac-sha2-256, hmac-sha2-
256-96, hmac-md5-96 and hmac-sha1-96 hashing algorithms.  

 Supports publickey, password and keyboard-interactive authentication methods  

 Supports RSA and DSA private key  

 Supports DES-EDE3-CBC, DES-EDE3-CFB, DES-CBC, AES-128-CBC, AES-192-CBC 
and AES-256-CBC algorithms for private key encryption.  

 Supports two-factor or higher authentication  
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 Supports SOCKS4, SOCKS5 and HTTP Proxy 

 

Examples: 

To read help on registered with PowerShell functions, type: 

 

> get-help *ssh* 

 

 

To register a new SSH session to remote SSH-compatible host, type: 

 

> New-SshSession [hostname] [username] 

 

To invoke a SSH command ls on a target host having opened session, type: 

 

> Invoke-SshCommand [hostname] –Command 'ls' 

 

Read more detailed information on SSH.NET & usage with PowerShell: 

https://sshnet.codeplex.com/ 

http://www.powershelladmin.com/wiki/SSH_from_PowerShell_using_the_SSH.NET_library  

 

https://sshnet.codeplex.com/
http://www.powershelladmin.com/wiki/SSH_from_PowerShell_using_the_SSH.NET_library
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3.7.7 Telnet Client 

With Telnet Client, Windows users can connect to a remote computer running a Telnet 
server and run applications on the remote computer or perform administrative tasks on 
it.  

 

 

 

Telnet uses the Telnet protocol (part of the TCP/IP protocol suite) to connect to a 
remote computer over a network.  

 

Type: 

 

 > telnet.exe /? 

 

To see the list of commands available and the syntax. 
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4 About Boot Priority 

To boot from a CD, DVD or USB device, make sure that the device has the boot 
sequence priority over the hard drive. 

 

4.1 BIOS Boot 

BIOS (Basic Input Output Subsystem) is a programmable chip that controls how 
information is passed to various devices in the computer system. A typical method to 
access the BIOS settings screen is to press ESC, F1, F2, F8 or F10 during the boot 
sequence. 

 

BIOS settings allow you to run a boot sequence from a removable disk, a hard drive, a 
CD-ROM drive or an external device. You may configure the order that your computer 
searches these physical devices for the boot sequence. The first device in the order list 
has the first boot priority. For example, to boot from a CD-ROM drive instead of a hard 
drive, place the CD-ROM drive ahead of the hard drive in priority. 

 

 

 

Before you set boot priority for a USB device, plug the device into a USB port. 

To specify the boot sequence: 

1. Start the computer and press ESC, F1, F2, F8 or F10 during the initial startup 
screen. Depending on the BIOS manufacturer, a menu may appear. 

2. Choose to enter BIOS setup.  The BIOS setup utility page appears. 
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3. Use the arrow keys to select the BOOT tab. System devices appear in order of 
priority. 

4. To give a CD or DVD drive boot sequence priority over the hard drive, move it to 
the first position in the list. 

5. To give a USB device boot sequence priority over the hard drive, do the following: 

 Move the hard drive device to the top of the boot sequence list. 

 Expand the hard drive device to display all hard drives. 

 Move the USB device to the top of the list of hard drives. 

6. Save and exit the BIOS setup utility. 

The computer will restart with the changed settings. 

 

Some computer manufacturers allow you to select the device that contains the boot 
sequence from a special device selection menu. The example below uses a Dell system 
board. 

 

To set boot priority using a device selection menu: 

1. When the computer starts to boot up, after the manufacturer's ID screen, press 
F12 several times. The device selection menu appears.   

2. Use the up and down arrows to select CD-ROM or an USB Flash Drive.  

3. To boot from the selected device, press ENTER.  

 Note  Using an incorrect BIOS setting can cause a system malfunction. Please 
follow the BIOS guide provided with your computer motherboard. If you 
read these instructions and you are not sure how to change a setting, it is 
better to leave it as the default setting.  

 

Active@ Boot Disk is able to boot both legacy BIOS or UEFI secure boot systems.  

However, if for some reason, BIOS mode does not boot the machine (computer hangs 
up, crashes, etc...), try UEFI secure boot mode. 
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4.2 UEFI Secure Boot 

 

Some modern computers use new advanced UEFI secure boot approach instead of the 
standard BIOS boot. In case if your machine does not boot after you set up boot 
priority as it is described above, you should check whether BIOS boot is enabled 
(Legacy mode), or UEFI mode.  

Here is how you can check your BIOS settings. 

At the moment of turning on your computer, you will see an option to enter SETUP. 
Depending on the manufacturer of your system, you can press the DEL key, the F2 key 
or another key that is listed on screen to access the system BIOS. If you are not sure, 
consult the User Guide that came with your computer or call the manufacturer's 
technical support for assistance. 

Once in your system BIOS, look under the Boot menu to find an option that reads 
"UEFI/BIOS Boot Mode" or "UEFI Boot". In the case of "UEFI/BIOS Boot Mode" switch 
the mode from "UEFI" to "Legacy" mode, or backward. 

 

Active@ Boot Disk is able to boot both legacy BIOS or UEFI secure boot systems.  

However, if for some reason, UEFI mode does not boot the machine (computer hangs 
up, crashes, etc…), try legacy BIOS boot mode. 
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5. Frequently Asked Questions 

5.1 How to load Active@ Boot Disk over the network via PXE 
environment? 

 

There are several steps required, configuring WinPE WIM, Boot Manager and PXE Server. 

For the configuration steps, let's assume that inserted Active@ Boot Disk has a D: letter in 

our configuration environment. 

Step 1: Copy WinPE Source Files onto PXE Server 

 Map a network connection to the root TFTP directory on the PXE/TFTP server (let’s assume 

it has a F: letter) and create there a \Boot folder (full name F:\Boot) 

 Copy the bootable Windows PE image (D:\SOURCES\BOOT.WIM) to the F:\Boot folder 

(on PXE/TFTP server) 

 Copy the BOOT.SDI file from D:\BOOT folder of inserted Active@ Boot Disk to the 

F:\Boot folder (on PXE/TFTP server) 

 Copy the BCD file from D:\BOOT folder of inserted Active@ Boot Disk to the F:\Boot 

folder (on PXE/TFTP server) 

Step 2: Configure custom boot configuration (optional) 

In case if default boot configuration supplied with Active@ Boot Disk (stored in file BCD) does 

not work for you, you can configure your custom boot configuration: 

 On a Windows® 7 computer or in a Windows PE environment, create a BCD store by using 

the BCDEdit tool 

 Create the RAMDISK setting, BOOTMGR and OSLoader settings for the Windows PE image 

 Copy the BCD file to the F:\Boot folder (on PXE/TFTP server) 

Step 3: Deployment process 

 Configure your PXE/TFTP server to point PXE clients to download Wdsnbp.com 

 A client is directed (by using DHCP Options or the PXE Server response) to 

download Wdsnbp.com 

 Wdsnbp.com validates the DHCP/PXE response packet and proceeds to download 

PXEBoot.com 

 PXEBoot.com downloads Bootmgr.exe and the BCD store. The BCD store must reside in 

a \Boot directory in the TFTP root folder. Additionally, the BCD store must be called BCD 
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 Bootmgr.exe reads the BCD operating system entries and downloads Boot.sdi and the 

Windows PE image 

 Bootmgr.exe begins booting Windows PE by running Winload.exe within the Windows 

PE image 

5.2 Customizing WIM 

 

We are using a WinPE environment that is booted into via PXE from a Windows Deployment 

Server. I am wondering if there is a way for us to copy registry information and files into the 
WIM file that we boot from so the applications are already installed and registered? Or will I 

need to script the installation and registration to occur each time we boot into WinPE? 
 

Customizing WIM is a complex task, however it can be done. To accomplish this, run the 

following: 
 

 1. Mount WIM: 
 

Dism /Mount-Wim /WimFile:D:\sources\boot.wim /index:1 /MountDir:D:\! 

 

2. Attach Registry from a file to your local registry, add your values, unload registry: 
 
reg load HKLM\my D:\!\windows\system32\config\software 

reg add "HKLM\my\Microsoft\Windows NT\CurrentVersion\Fonts" /v "Courier New 

(TrueType)" /t REG_SZ /d cour.ttf 

reg unload HKLM\my 

 
3. Unmount WIM: 

 
Dism /unmount-Wim /MountDir:d:\! /Commit 

 

 

This requires Microsoft's Windows AIK and done from a command prompt 
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5.3 Disks not visible under Boot Disk environment 

The Active@ Boot Disk cannot see the drives in my system, what can I do so they 
would be detected? 
 

Suggestions: The set of common drivers in Active@ Boot Disk may not include the driver for 
your hard drive controller. 

 
In this case, you can add or load additional drivers yourself... 

 

Firstly, you will need to identify the type of hard drive controller you have in your computer. 
You can look that up in the properties of My Computer — Device Manager — under IDE 

ATA controllers or under Storage controllers. 
 

Another way is to look up the specifications of your computer from the manufacturer's web 
page. 

Whether you have a Dell, HP, Sony, Gateway or other brand of system, the manufacturer's 

support pages will identify what controller you have based on your system's model number or 
other service identifying number. 

 
The manufacturer's support pages are also the location of where you can download the drivers 

for your system. You will need to download the 64 bit drivers (x64 architecture) as the 

Active@ Boot Disk environment is based on a 64 bit version of Windows. Once you have 
downloaded the drivers, you can load them in one of three ways. 

 
 When running the Boot Disk Creator add the driver INF and accompanying SYS files to 

the "Add Drivers" section. These will be saved to the bootable media and automatically 

loaded when booting your system up. 
 You can load the drivers after boot-up. Once booted into Active@ Boot Disk, Click on the 

Start menu, then select "Load Driver". The dialog allows you to browse to the 

location of where you stored the driver INF and accompanying SYS files. Clicking on the 

INF file will load the drivers. 
 Create a folder called BootDisk_Drivers on the root of any drive that will be visible after 

boot (without requiring the extra drivers) and copy the required files to that folder. 

During the boot process, these drivers will be loaded automatically. 
 

You should be able now to access your hard drives after the driver is successfully loaded. 

 
Tip: You can remove the Boot Disk Media at any time after boot-up and insert the media 

where you have stored your driver files to be loaded. 
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Glossary 

BIOS settings  
Basic Input Output Subsystem. Programmable chip that controls how information is 
passed to various devices in the computer system. A typical method to access the BIOS 
settings screen is to press ESC, F1, F2, F8 or F10 during the boot sequence.  

 

boot priority  
First device, or any device that is higher in the order list having preference over devices 
that are lower in the order. BIOS settings allow you to run a boot sequence from a 
floppy drive, a hard drive, a CD-ROM drive or a flasd drive. You can configure the order 
in which your computer searches these physical devices for the boot sequence. For 
example, to boot from a CD-ROM drive instead of a hard drive, place the CD-ROM drive 
ahead of the hard drive in priority.  

 

boot record  
See MBR. 

 

compressed cluster  
Data that uses less disk space. When you set a file or folder property to compress data, 
the file or folder uses less disk space. While the size of the file is smaller, it must use a 
whole cluster in order to exist on the hard drive. As a result, compressed clusters 
contain "file slack space". This space can contain residual confidential data from the file 
that previously occupied this space. KillDisk can wipe out the residual data without 
touching the existing data.  

 

cluster  
Logical group of disk sectors, managed by the operating system, for storing files. Each 
cluster is being assigned with a unique number when being used. The operating system 
keeps track of clusters in the hard disk's root records or MFT records. (See lost cluster)  

 

exclusive access  
Lock that is applied to a partition for exclusive writing access, for example while 
recovering deleted or damaged files or folders. The recovery operation must have 
exclusive access to the target partition while recovering files. If another application or 
the operating system is using the target partition, you must close all applications or 
system processes that may be using the target partition before locking it. 

 

FAT  
File Allocation Table. File that contains the records of every other file and directory in a 
FAT-formatted hard disk drive. The operating system needs this information to access 
the files. There are FAT32, FAT16 and FAT versions.  
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free cluster  
A cluster that is not occupied by a file data. This space may contain residual confidential 
data from the file that previously occupied this space.  

 

file slack space  
Unused portion of a cluster. The smallest file (and even an empty folder) takes up an 
entire cluster. A 10-byte file will take up 2,048 bytes if that is the cluster size. This space 
could contain residual confidential data from the file that previously occupied this space.  

 

deleted boot records  
Damaged or erased MBR. In a damaged disk, if the location of the boot records is 
known, the partition table can be reconstructed.  

 

hive  
Highest level of organization in the Windows registry. At this level, system and local 
variables are stored. 

 

ISO  
Informal term for a disk image in the ISO 9660 file standard format. ISO 9660 file 
system is a standard, published by the International Organization for Standardization. It 
defines a file system for CD-ROM or DVD-ROM media that allows you to read the same 
CD or DVD whether you're on a PC, Mac, or other major computer platform. Making a 
disk image in the ISO 9660 file standard (an ISO image) is a common way to 
electronically store and transfer the contents of a hard drive. An ISO image often has 
the filename extension .ISO (although not necessarily), and is commonly referred to as 
an "ISO".  

 

lost cluster  
Cluster with an assigned number in the file allocation table, even though it is not 
assigned to any file. You can free up disk space by reassigning lost clusters. In DOS and 
Windows, you can find lost clusters with the ScanDisk utility.  

 

MBR   
Master Boot Record. All disks start with a boot sector. When you start the computer, the 
code in the MBR executes before the operating system is started. The location of the 
MBR is always track (cylinder) 0, side (head) 0, and sector 1. The MBR contains a file 
system identifier.  

 

MFT records  
Master File Table. File that contains the records of every other file and directory in an 
NTFS-formatted hard disk drive. The operating system needs this information to access 
the files.  
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root records  
See FAT. 

 

PXE Boot 

Preboot Execution Environment (PXE) - set of standards that enables a computer to load 
an operating system (OS) over a network connection. 

 

SAM  
Security Account Manager. Database stored as a registry file in Windows. It stores users' 
passwords in a hashed format. Since a hash function is one-way, this provides some 
measure of security for the storage of the passwords. 

 

sector  
Smallest unit that can be accessed on a disk. Sectors are segments within each track.  

 

track  
Circle of data around a disk. Tracks form concentric circles on a disk. 

 

unallocated space  
Space on a hard disk where no partition exists. A partition could have been deleted or 
damaged or a partition has never been created.  

 

Windows system caching  
Windows reserves a specified amount of volatile memory for file system operations. This 
is done in RAM because it is the quickest way to do these repetitive tasks.  

 

Windows system records  
The Windows registry keeps track of almost everything that happens in windows. This 
enhances performance of the computer when doing repetitive tasks. Over time, these 
records can take up a lot of space. 


